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この度は GW Insturument 社の計測器をお買い上げいただきありがとう
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2．不当な修理、調整、改造がなされた場合。 

3．取扱いが不適当なために生ずる故障、損傷。 

4．故障が本製品以外の原因による場合。 

5．お買上げ明細書類のご提示がない場合。 

お買上げ時の明細書（納品書、領収書など）は保証書の代わりとなりま
すので、大切に保管してください。 

また、校正作業につきましては有償にて受け賜ります。  

この保証は日本国内で使用される場合にのみ有効です。 

This warranty is valid only Japan. 
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安全上の注意 
この章は本器の操作及び保存時に気をつけなければなら
ない重要な安全上の注意を含んでいます。 操作を開始す
る前に以下の注意をよく読んで、安全を確保してください。 

安全記号 

以下の安全記号が本マニュアルもしくは本器上に記載されています。 

 

 WARNING 

警告: ただちに人体の負傷や生命の危険につながる
恐れのある箇所、用法が記載されています。 

 CAUTION 

注意: 本器または他の機器へ損害をもたらす恐れのあ
る箇所、用法が記載されています。 

 

危険:高電圧の恐れあり 

 

危険・警告・注意:マニュアルを参照してください 

 

保護導体端子 

 

シャーシ（フレーム）端子 
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安全上の注意 

一般注意事項 

 CAUTION 

• 重量のある物を本器に置かないでください。 

• 激しい衝撃または荒い取り扱いを避けてください。
本器の破損につながります。 

• 裸線や金属棒を端子に接続しないでください。 

• 電源入力電圧は、42Veak（30Vrms）を越えないでく
ださい。 

• 電源付近と建造物、配電盤やコンセントなど建屋
施設の測定は避けてください。(以下の注意事項参
照)。 

• 本器付属プローブおよび入力端子 BNCは、感電
を避けるため保護されています。一般のプローブ
を使用する場合にはご注意ください。 
また、入力端子 BNCの GND 側端子の金属も特
殊形状のため一般のケーブルを接続する場合、
GND の接触にご注意ください。 

 
(測定カテゴリ) EN61010-1:2001 は測定カテゴリと要求事項を以下

の要領で規定しています。 GDS-122 はカテゴリ Ⅰの部類に入りま

す。 

• 測定カテゴリ IVは、建造物への引込み電路、引込み口から電
力量メータおよび一次過電流保護装置（分電盤）までの電路を

規定します。 

• 測定カテゴリ IIIは、直接分電盤から電気を取り込む機器（固定
設備）の一次側および分電盤からコンセントまでの電路を規定し

ます。 

• 測定カテゴリ IIは、コンセントに接続する電源コード付機器（家
庭用電気製品など）の一次側電路を規定します。 

• 測定カテゴリ Iは、コンセントからトランスなどを経由した機器内
の二次側の電気回路を規定します。 

使用方法 

 WARNING 

危険性を避けるために、GDS-122 にのみご使用くださ
い。 
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バッテリーの充電

について。 

 WARNING 

推奨温度０℃～50℃で、オシロスコープ本体からのみ
バッテリパックに再充電してください。 

電源 

 WARNING 

• AC アダプタ電源電圧: 100 ～ 240V AC, 50/60Hz 

• 電源電圧は 10%以上変動してはいけません。 

• 必ず付属 AC アダプタをご使用ください。 

• 必ず、先ず ACアダプタを電源コンセントに接続し
その後、本器に接続してください。 

清掃 

 

• 清掃の前に電源コードを外してください。 

• 清掃には洗剤と水の混合液に、柔らかい布地を使
用します。液体が中に入らないようにしてください。 

• ベンゼン、トルエン、キシレン、アセトンなど危険な
材料を含む化学物質を使用しないでください。 

設置・操作環境 

 WARNING 

• 設置場所：室内で、直射日光に当たらず、ほとんど
ホコリがない場所でご使用ください。下記を参照 

• 相対湿度： < 75% 

• 高度： < 2000m 

• 温度： ０℃～40℃ 

 
(汚染度) EN61010-1:2001 は測定カテゴリと要求事項を以下の要領

で規定しています。 GDS-122 は汚染度 2に該当します。 

汚染の定義は「絶縁耐力か表面抵抗を減少させる固体、液体、また

はガス(イオン化気体)の異物の添加」を指します。 

• 汚染度 1: 汚染物質が無いか、または有っても乾燥しており、非
電導性の汚染物質のみが存在する状態。汚染は影響しない状

態を示します。 

• 汚染度 2: 結露により、たまたま一時的な電導性が起こる場合を
別にして、非電導性汚染物質のみが存在する状態。 
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汚染度 3: 電導性汚染物質または結露により電導性になり得る非電

導性汚染物質が存在する状態。 

 •  

カバー・パネル 

 WARNING 

• サービスマン以外の方がカバーやパネルを取り外
さないで下さい。本器を分解することは禁止されて

います。 

電源 

 WARNING 

• AC アダプタ電圧: 100 ～ 240V AC, 50/60Hz 

• 電源電圧は 10%以上変動してはいけません。 

• ACアダプタは本器に付属しているもののみ使用し
てください。 

使用中の異常に

関して 

 WARNING 

• 製品を使用中に、製品より発煙や発火などの異常
が発生した場合には、ただちに使用を中止し主電

源スイッチを切り、電源コードを抜いてください。 

ヒューズ 

 WARNING 

• ヒューズが溶断した場合，使用者がヒューズを交換
することができますが，マニュアルの保守等の内容

に記載された注意事項を順守し，間違いのないよう

に交換してください。ヒューズ切れの原因が判らな

い場合，製品に原因があると思われる場合，ある

いは製品指定のヒューズがお手元にない場合は，

当社までご連絡ください。間違えてヒューズを交換

された場合，火災の危険があります。 

• ヒューズ定格: T1A/250V 

• 電源を入れる前にヒューズのタイプが正しいことを
確かめてください。 

• 火災防止のために、ヒューズ交換の際は指定され
たタイプのヒューズ以外は使用しないでください。 
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• ヒューズ交換の前は電源コードを外してください。 

• ヒューズ交換の前にヒューズ切断の原因となった問
題を解決してください。 

清掃 

 

• 清掃の前に電源コードを外してください。 

• 清掃には洗剤と水の混合液に、柔らかい布地を使
用します。液体が中に入らないようにしてください。 

• ベンゼン、トルエン、キシレン、アセトンなど危険な
材料を含む化学物質を使用しないでください。 

設置・操作環境 

 WARNING 

• 設置および使用箇所: 屋内で直射日光があたらな
い場所、ほこりがつかない環境、ほとんど汚染のな

い状態(以下の注意事項参照)を必ず守ってくださ

い。 

• 可燃性雰囲気内で使用しないで下さい。 

• 高温になる場所で使用しないでください。 

• 湿度の高い場所での使用を避けてください。 

• 腐食性雰囲気内に設置しないで下さい。 

• 風通しの悪い場所に設置しないで下さい。 

• 傾いた場所、振動のある場所に置かないで下さ
い。 

• 相対湿度: ≦ 75%  

• 高度: < 2,000m 

• 気温: 0℃ ～ 50℃ 

 (汚染度) EN61010-1:2001 は測定カテゴリと要求事項を以下の要領

で規定しています。 GDS-122 は汚染度 2に該当します。 

汚染の定義は「絶縁耐力か表面抵抗を減少させる固体、液体、また

はガス(イオン化気体)の異物の添加」を指します。 

• 汚染度 1: 汚染物質が無いか、または有っても乾燥しており、非
電導性の汚染物質のみが存在する状態。汚染は影響しない状

態を示します。 

• 汚染度 2: 結露により、たまたま一時的な電導性が起こる場合を
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別にして、非電導性汚染物質のみが存在する状態。 

• 汚染度 3: 電導性汚染物質または結露により電導性になり得る
非電導性汚染物質が存在する状態。 

保存環境 • 保存場所: 屋内 

• 相対湿度: ≦ 75%  

• 気温: ‐10℃～ 70℃ 

調整・修理 

 

• 本製品の調整や修理は、当社のサービス技術およ
び認定された者が行います。 

• サービスに関しましては、お買上げいただきました
当社代理店（取扱店）にお問い合わせ下さいますよ

うお願い致します。なお、商品についてご不明な点

がございましたら、弊社までお問い合わせください。 

保守点検につい

て 

  

• 製品の性能、安全性を維持するため定期的な保
守、点検、クリーニング、校正をお勧めします。 

校正 

  

• この製品は、当社の厳格な試験・検査を経て出荷
されておりますが、部品などの経年変化により、性

能・仕様に多少の変化が生じることがあります。 

また、製品の性能・仕様を安定した状態でご使用い

ただくために定期的な校正をお勧めいたします。 

校正についてのご相談はご購入元または当社まで

ご連絡ください。 

ご使用について 

 

• 本製品は、一般家庭・消費者向けに設計・製造され
た製品ではありません。電気的知識を有する方が 

マニュアルの内容を理解し、安全を確認した上でご

使用ください。また、電気的知識のない方が使用さ

れる場合には事故につながる可能性があるので、

必ず電気的知識を有する方の監督下にてご使用く

ださい。 
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はじめに 
この章は、GDS-122 の概要と、パッケージ内容について
説明します。 

GDS-122 を開封した後に、パッケージ内容をチェックして
ください。また、主な機能とフロントパネルおよびキー説明
とインタフェースについて説明します。 

. 

 

 

パッケージ内容 ................................................................ 8  
主な特徴 ........................................................................ 9  
フロントパネルとキー 概要 ................................................ 10 
概要 ............................................................................ 12  
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パッケージ内容 

キャリングケース 

 

GDS-122 

 

AC-DC アダプタ 

 

オシロスコープ用プローブ x 2 

 

Probe 調整用ドライバ 

 

マルチメータ用テストリード x 2 

 

大電流測定用拡張モジュール 

 

小キャパシタンス測定用 

拡張モジュール 

 

シリアルデータ通信用ケーブル 

 

CD-ROM 

ユーザーマニュアル（本書） 

付属ソフトウェア“DS_WAVW” 
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主な特徴 

オシロスコープ • 2 チャンネル 

• 周波数帯域：20MHz 

• 最高サンプリングレート：100MS/s 

• 立上り時間：≤ 17.5ns 

• 水平時間：5ns ～ 5s/div 

• 垂直感度：5mV ～ 5V/div 

• メモリ長：6k/ch 

• オシロスコープとマルチメータ間は入力絶縁 

• Autoset 機能 

• トリガモード： Auto, Free run, Single shot, Edge, ビ
デオ 

• 2 カーソル 

• 自動測定：5 項目 

• 画像メモリ：4 

• 自己校正機能 

マルチメータ • 電圧,電流, 抵抗, Continuity, Diode, キャパシタンス
測定 

• 最大 20A amplitude 

• True RMS 測定 

• オシロスコープとマルチメータ間は入力絶縁 

一般 • USB インターフェース 

• 3.8 インチ カラー LCD ディスプレイ,  
分解能：320 x 240  

• AC アダプタまたは Li-ion バッテリー動作 

• 小型：180mm x 113mm x 40mm  

• 軽量：690g 
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フロントパネルとキー 概要 

LCD
ディスプレイ

MENUキー ＋
Up/Downキー

RUN/STOPキー
AUTOSETキー
DMM/OSCキー

Aスイッチ
Vスイッチ
Rスイッチ

ディスプレイ
輝度スイッチ

ACアダプタ入力
plug

USBポート

mA端子
オシロスコープ
CH1/2入力端子

COM端子 V/Ω端子 CX端子

OSCオプションキー
+矢印キー

F1～F5キー

電源スイッチ

プローブ補正用出力

 

DSO  : オシロスコープの機能説明 
DMM  : マルチメータの機能説明 

AC アダプタ端子 AC アダプタの入力端子です。DC 8.5V, 1500mA. 

USB ポート PC接続用 USB ケーブルを接続します。 

LCD display 3.8 インチ, 320 x 240 分解能, カラーLCD ディスプレイ 

OSC オプションキ
ー + 矢印キー 

DSO  以下のパラメータを設定します。垂直レベル
とスケール。(page19),水平レベルとスケール 
(22 ページ),トリガレベル (23 ページ), カーソ
ル位置 (39 ページ). 

MENU キー + 
Up/Down キー 

DSO  右メニューを表示とメニュー項目の選択 
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RUN/STOP キー DSO  手動で run または stop を選択する。トリガの
詳細は 23 ページを参照ください。 

 

DSO  : オシロスコープ機能 
DMM  : マルチメータ機能 

RUN/STOP キー DMM  測定の停止 (stop) or 動作 (run)  

AUTOSET キー DSO  入力信号に最適に水平・垂直スケールとトリ
ガレベルを自動選択します。詳細は 16 ペー
ジを参照ください。 

 DMM  測定モードの切替をします。詳細は 87 ペー
ジ(電流), 4 ページ(電圧),と 89 ページ(インピ
ーダンス)を参照ください。 

DMM/OSC キー オシロスコープとマルチメータを切り替えます。 

CH1/2 入力端子 DSO   CH1 と CH2 の入力端子です。 

CX 入力端子 DMM  キャパシタ測定用テストリード端子。 

V/Ω 入力端子 DMM  小容量キャパシタンス、電圧、インピーダンス
用の赤テストケーブル入力端子。 

COM 入力端子 DMM  黒リード（COM/GND）入力端子。 

mA 入力端子 DMM  電流測定用赤リード入力端子。 

R スイッチ DMM  下記の測定選択をします。 

インピーダンス(89 ページ), diode (90 ページ), 
continuity (92 ページ), キャパシタンス 
(page93). 

V スイッチ DMM  電圧測定を選択 (エラー! ブックマークが定義
されていません。ページ). 

A スイッチ DMM  電流測定を選択 (87 ページ). 

Power スイッチ 電源の ON/OFF スイッチ。 

F1 ‒ F5 キー ディスプレイ下に表示されるメニュー項目を選択する。 

輝度スイッチ ディスプレイ輝度の明るい、または暗いを選択する。 
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概要 

概要 本書は 7章ありオシロスコープとマルチメータで分か
れています。 

安全上の注意 

  

安全上の注意は、本器を取り扱う上で事前に注意す
べき重要な安全関連の事項を説明しています。必ず
お読みください。 

先ず始めに (7 ペー
ジ) 

先ず始めに、この章は本器の概要と主な機能、パッケ
ージの内容、フロントパネルについて説明しています。 

オシロスコープの使
い方。 (13 ページ) 

オシロスコープの使い方の章では、本器のオシロスコ
ープ機能の詳細と PC ソフトウェアについて述べてい
ます。章の始めにサンプルと基本操作について説明し
より複雑な測定と設定について説明します。始めて本
器を使用する場合は、基本操作の項から始めてくださ
い。さらに進んだ方法としてメニューツリー、ショートカ
ットについて説明しています。 

マルチメータの使い
方 (83 ページ) 

マルチメータの使い方の章では、本器のマルチメータ
機能について説明します。もっとも基本的な電圧、電
流と抵抗について始めに説明しています。 

FAQ 

(95 ページ) 

FAQの章では、よくある質問について説明していま
す。 

定格  定格はオシロスコープとマルチメータと一般仕様に分
かれて記載されています。 

Index 

(100 ページ) 

索引の章では、アルファベット順で本書のキーワード
を掲載しています。 
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オシロスコープを使用する。 

この章では本器のデジタルストレージオシロスコープにつ
いて波形観測の設定と方法、測定機能およびシステム設
定および機能について説明をします。メニューの項目では、
全ての機能概要とクイックアクセスについて説明します。
マルチメータ機能にすいては 83 ページを参照してください。 

基本操作 ...................................................................... 14  
構成 ............................................................................ 19  
自動測定 ...................................................................... 36  
機能 ............................................................................ 43  
校正 ............................................................................ 49  
保存/読出し .................................................................. 52  
メニューツリー / 操作のショートカット ................................... 55 
ソフトウェアについて ........................................................ 60  
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基本操作 

操作手順 この章では、本器の設定方法と入力信号の観測手順
について述べています。 

1. 電源をON にする。 
2. 入力信号を接続する。 
3. Autoset キーを使用してディスプレイに表示する。 
4. スケールを調整する。 
5. 波形の位置を調整する。 

Advanced 
operations 

より高度な操作については下記の章を参照してくださ
い。 

• 設定 (19 ページ) 

• 測定 (36 ページ) 

• より高度な観測方法 (43 ページ) 

• 校正について (49 ページ) 

1. 電源の投入 

1. 電源スイッチを
押します。 

電源スイッチを押します。初期画面が表
示されます。 

 

 ディスプレイの輝度を調整するには本体
左側面のボタンを押します。ボタンを押し
ます。ボタンを押すたびに「明るい」「暗
い」を繰り返します。 

 

2. オシロスコープ
機能を有効にし
ます。 

オシロスコープモードにするにはいずれ
かのキーを押します。（例えば MENU キ
ー)  ディスプレイ左上端のバッテリーレベ
ルを確認し、残量が 25％未満になったら
ACアダプタを接続し充電してください。 

(例：) 

MENU
 

 > 75% 

 

75% 

 

50% 

 

25% 

 

< 25% 

 

操作モードの切替 マルチメータモードが表示されていると
き、DMM/OSCキーを押しオシロスコー

DMM/OSC
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プモードに切り替えます。 

スタンドを使う 本器背面のバーを使用し斜
めに立てることができます。 

 

注意 電源スイッチを ON にしても起動しない場合は、バッテ
リを充電する必要があります。ACアダプタを接続して
少なくとも 15 分以上充電してください。 

2. 入力信号を接続する。 

1. プローブを接続
する。 

被測定物（DUT）と本器 CH1（CH2）入力をプローブで
接続します。 

プローブ補正 

注意 

付属のプローブを使用する場合は使用する前に、プロ
ーブ補正を必ず実行してください。 

49 ページ 

2. プローブのアッ
テネータを設定
する。 

先ず始めは、過大な電圧を本器に入力しないために
プローブ減衰器をｘ10 位置に設定することをお勧めし
ます。 

 

3. ディスプレイの 
減衰率を設定し
ます。 

1. プローブの減衰率をｘ10 にした場合、ディスプレイ
レベルをｘ10 に設定し入力信号のレベルをそのま
ま読めるようにします。MENU キーと UP/DOWN
キーで CH1 または CH2 の SETUP メニューを開き
ます。 
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 2. F3 キーを押し、プローブの減衰率をｘ10 に設定し
ます。減衰率の設定に従ってディスプレイ左下端
垂直スケールが設定に従って変わります。 

10 X
ProbeCH2 SETUP

F3

MENU
CH1 SETUP

 

3. Autoset 機能を使用する。 

概要 Autoset 機能は入力信号に従って下記パラメータを 
自動的に設定します。 

CH1/CH2 on/off 

• 垂直スケールとレベル 

• 水平スケールとレベル 

• トリガレベル 

Autoset 機能を 
使用する。 

AUTOSET キーを押します。入力信号
が最適に観測できるよう自動的に設定
します。 

AUTOSET
 

【例】 

 

Autoset 前                 Autoset 後 
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4. ディスプレイ表示項目について 

トリガ状態

トリガ位置

水平ポジション

垂直位置

周波数/CH OFF

垂直軸センタ位置

垂直スケール 水平スケール
 

トリガ状態 • トリガが掛かっている状態 

• トリガ待ち状態 

• トリガ停止状態 

Trig’d  

AUTO  

STOP  

 トリガ ON/OFF（RUN/STOP）を制御
するために RUN/STOPキーを押しま
す。 

RUN/STOP
 

5. 波形のスケールを調整する。 

メニューの選択 OSC OPTION キーを下記のメニュ
ーが表示されるまで繰り返し押しま
す。 

 ‒ Time Base 

 ‒ CH1 (or CH2) Volts/div 

OSC
OPTION

 

 

Horizontal scaleVertical scale  

水平スケールの調 右/左キーで水平スケールを調整します。 
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整 

 現在の状態 

  

 

   

UP/DOWN キーを使い垂直スケールを調整します。 垂直スケールの調
整 

現在の状態 
  

 

   

6. 波形の位置を調整 

メニュー選択 OSC OPTION キー下記のメニュー
が表示されるまで押します。 

 ‒ Time 

 ‒ CH1 (or CH2) Zero 

OSC
OPTION

 

 

垂直センター
位置

水平センター

位置

 

Left/Right キーで水平ポジションを変えます。 水平ポジションの調
整 

 

基本位置 
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Up/Down キーで垂直ポジションを変えます。 垂直ポジションを調
整する。 

 
基本位置 

 

 

   

構成 

概要 この章では、正しく測定するためのパラメータの変更
方法について説明します。 

校正項目 • Channel (垂直軸 vertical) 設定 

• 水平軸設定 

• トリガ設定 

• アクイジションモード 

• 言語 

• ディスプレイ設定 

• システム情報 (表示のみ) 

19 ページ 

22 ページ 

23 ページ 

26 ページ 

31 ページ 

32 ページ 

33 ページ 

チャンネル (垂直軸) 設定 

概要 チャンネル設定は、波形が垂直軸または電圧スケー
ルでどのように表示するかを設定します。 

 ポジション 波形の垂直ポジションを設定します。 

 スケール 垂直スケール（V/div）を設定します。 

範囲： 5mV/div ～ 5V/div 

 CH on/off チャンネル表示のON/OFF をします。 

 カップリン
グ 

AC または DC結合を選択します。DC結
合は信号の全てを表示します。AC結合
は DC成分を除去した信号を表示します。 
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 反転 波形の上下を反転します。 

 減衰率の
設定 

表示単位(実際の信号は変わりません)を
選択します。表示されたものをプローブの
減衰率(15 ページ)、特に x10 と合わせま
す。 

垂直ポジション設定 1. OSC OPTION キーを下記の 
メニュー表示が出るまで押しま
す。 
LEFT/RIGHT ‒ Time 
UP/DOWN ‒ CH1 (or CH2) Zero 

OSC
OPTION

 

 

 

2. Up/Down キーで垂直ポジションを変更します。  

 
Original 

 

 

   

垂直スケールを設
定します。 

1. OSC OPTION キーを下記のメニ
ュー表示が出るまで押します。 
LEFT/RIGHT ‒ Time Base 
UP/DOWN ‒ CH1 (or 2) Vol 

OSC
OPTION

 

 

 

2. Up/Down キーを押し垂直スケールを変更します。  

 
Original 
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チャンネル
ON/OFF の選択 

1. MENU キーを押し Up/Down キーで CH1（CH2）
SETUP メニューを選択します。 

2. F2（Channel）を押すたびにチャンネル表示が
ON/OFF します。 

MENU
CH1 SETUP

CH2 SETUP

ON
Channel

OFF

F2
 

注意 AUTOSET 機能を使用するとチャンネルは自動的に
ON または OFF します。(16 ページ) 

結合モードの選択 1. MENU キーを押し Up/Down キーで CH1(CH2) 
SETUP を選択します。 

2. F1（Coupling）キーを押し DCまたは AC結合を選
択します。 

MENU
CH1 SETUP

CH2 SETUP

AC
Coupling

DC

F1
 

DC 結合は信号の DC成分と AC成分が観測でき
ます。 

AC結合は信号の AC成分のみ観測できます。 

 DC 結合 

（DC成分を含んでいる
のでポジションマーク
は波形の底になりま
す。） 

 

 AC 結合 

(DC成分が除去されて
いるのでポジションマ
ークは波形のセンター
になります。) 

 



  GDS-122 User Manual 

22 

チャンネル表示を
反転する。 

1. MENU キーを押し Up/Down キーで
CH1(CH2)SETUP メニューを選択します。 

2. F4（Inverted）キーで波形表示を反転します。 

MENU
CH1 SETUP

CH2 SETUP

OFF
Inverted

ON

F4
 

 反転 off 

 

反転 on 

 

減衰率の選択 1. MENU キーを押し Up/Down キーで
CH1(CH2)SETUP メニューを選択します。 

2. F3(Probe)を押しプローブ減衰率を選択します。 

MENU
CH1 SETUP

CH2 SETUP
1 X

Probe

1000 X
100 X
10 X

F3
 

水平軸の設定 

概要 水平軸設定は、波形の水平項目と時間スケールの設
定をします。 

 ポジション 波形の水平ポジションを設定します。 

 スケール 水平スケール（time/div）を設定します。 
範囲： 100ms/s ～ 10s/s 
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水平ポジションの設
定 

1. OSC OPTION キーを下記のメニ
ューが表示されるまで押します。 

LEFT/RIGHT ‒ Time 

 

OSC
OPTION

 

2. Left/Right キーを押し水平ポジションを変更しま
す。 

 

 

Original 

 

 

   

水平スケールの設
定 

1. OSC OPTION キーを下記のメ
ニューが表示されるまで押しま
す。 

LEFT/RIGHT ‒ Time Base 

 

OSC
OPTION

 

 2. Left/Right キーを押し水平スケールを変更します。 

 

 

Original 
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トリガ設定：通常の設定 

概要 トリガ設定は、入力信号にトリガをかける方法につい
て説明します。通常の設定ではトリガのスタート/ストッ
プ、トリガレベルの調整とトリガモードの変更について
説明します。 

• エッジトリガの詳細は 26 ページを参照ください。 

• ビデオトリガの詳細は 29 ページを参照ください。 

 状態表示 トリガの状態はディスプレイ右上端にアイ
コンで表示されます。 

 Run/Stop トリガの開始/停止を選択します。 

 トリガレベル 波形にトリガがかかるレベルを設定しま
す。 

トリガ状態表示 トリガ状態表示アイコンはディスプレイの右上端に表
示されます。 

 Trig’d  トリガがかかっています。 

 AUTO  トリガの状態にかかわらず輝線を表示しま
す。エッジトリガの Auto トリガで設定しま
す。(26 ページ) 

 Ready  トリガがかかっていません。トリガ待ち状態
です。エッジトリガの NORM トリガモードで
設定できます。 (26 ページ). 

 Scan  トリガ状態にかかわらす輝線を表示します。
波形はディスプレイ左から更新されます。水
平スケールが 100ms/div より遅くなると自
動的に SCAN モードに切り替わります。 

 STOP  トリガ状態にかかわらず停止します。再度ス
タートするにはシングルモードの場合、
RUN/STOPキーを押します。または、その
他のトリガモードに変更します。 
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 水平スケールとトリガ状態 

100ms/div 5s/div5ns/div

STOP

AUTO

Trig’d

Ready

Scan

 

Run/Stop Run/Stop キーを一度押すと、ほとんどの
場合トリガを停止し STOP アイコンが表
示されます。 

RUN/STOP
 

STOP  

 エッジトリガモードでシングルモードの場合、RUN/ 
STOPキーは、トリガ待ち状態の有効/無効として機能
します。(26 ページ) 

トリガレベル OSC OPTION キーを下記のメニューが
表示されるまで押します。 

OSC
OPTION

 

 LEFT/RIGHT ‒ Time 
UP/DOWN ‒ Trig 

 

 トリガレベル表示 

Trigger level
( 水平 )

Trigge r level
( 垂直 )

 

 矢印キーはトリガ位置を変更するのに使用します。 
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トリガ位置を
上に移動

トリガ位置を
下に移動

トリガ位置を
右に移動

トリガ位置を
左に移動

 

 Up と Down キーを同時に押す
とトリガレベルをリセットし、ゼ
ロレベルにします。 

 

 

 Left と Right キーを同時に押
すと水平トリガ位置をリセットし
ディスプレイ中央に移動しま
す。 

 

 

トリガ設定: エッジトリガ 

Overview エッジトリガは入力信号のエッジにトリガをかけます。
ビデオ信号を除いて全ての信号に使用します。 

• 通常のトリガ設定は 24 ページを参照ください。 

• ビデオトリガ設定は 29 ページを参照ください。 

 エッジトリガを選択するには以下の手順で選択してく
ださい。 

1. MENU キーを押します。UP/Down キーで TRIG 
MODE メニューを選択します。 

2. F1(Type)キーを押しエッジトリガの形式を選択しま
す。 

MENU TRIG MODE Edge
TYPE

F1
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 Slope 入力信号スロープの立上りまたは立ち下
がりを選択します。 

 Source トリガ信号源を CH1 または CH2 に 
設定します。 

トリガモードを選択します。 

Auto： 連続して信号を更新します。 

Normal： トリガが掛かったときのみ更新し
ます。 

 Mode 

Single： トリガがかかると一度のみ更新
します。 

 Coupling DC または AC結合と除去フィルタ（高周波
または低周波）を選択します。 

トリガスロープの選
択 

F2(SLOP)を押し、立上りまたは立下
りスロープを選択します。 Falling

Slope

Rising

F2  

 例：立上りエッジ 
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トリガ信号源の選択 F3（Channel）キーを押しトリガ信号源
（CH1 または CH2）を選択します。選択し
たトリガ信号のチャンネルはディスプレイ
右下に表示されます。 

Trigger source 
channel  

CH1
Source

CH2

F3  

トリガモードの選択 F4（Mode）キーを押しトリガモードを選択し
ます。トリガ状態アイコンがディスプレイの
右上端に表示されます。通常のトリガにつ
いては 24 ページを参照ください。 

Single
Mode

Auto
Normal

F4  

 Auto モード 

AUTO モードでは輝線は連続更新されトリガの状態に
かかわらずディスプレイに表示されます。 

100ms 5s5ns

AUTO

Trig’d Scanトリガ時の状態アイコン表示

トリガ状態でないときのアイコン Scan

水平スケール (/div )

 

 Normal モード 

ノーマルモードでは、入力信号にトリガがかかったとき
のみ更新されます。 

100ms 5s5ns

Trig’d Scan

ScanReady

トリガ時の状態アイコン表示

トリガ状態でないときのアイコン

水平スケール (/div )

 

 Single モード 

シングルモードでは RUN/STOPキーを押すとトリガ待
ち状態となりトリガが掛かると一度だけ波形を更新し
停止します。ふたたび波形を取り込むには再度
RUN/STOPキーを押します。 
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STOP

100ms 5s5ns

Scan

STOP

AUTO

Ready

トリガ時の状態アイコン表示

トリガ状態でないときのアイコン

水平スケール (/div )

 

カップリングモード
の選択 

F5（Coupling）キーを押すとトリガ結合が選
択できます。 

• AC： 波形の AC成分のみにトリガをか
けます。 

• DC: 波形の全ての成分（AC+DC）にトリ
ガをかけます。 

• LF Rjc: トリガ信号の低い周波数成分を
除去します。 

• HF Rjc: トリガ信号の高い周波数成分を
除去します。 

DC
Coupling

AC
LF Rjc
HF Rjc

F5  

トリガ設定: ビデオトリガ 

概要 ビデオトリガはビデオ信号を観測するためのモードで
す。ビデオ規格は NTSC、PAL または SECAM です。
通常のトリガについてはエッジトリガを使用します。 

• 通常のトリガ設定については 24 ページを参照くだ
さい。 

• エッジトリガの詳細については 26 ページを参照くだ
さい。 

 エッジトリガを選択するには下記の手順を実行してくだ
さい。 

1. MENU キーを押します。Up/Down キーで TRIG 
MODE メニューを選択します。 

2. F1(Type)キーでビデオトリガのタイプを選択します。 

MENU TRIG MODE Video
TYPE

F1
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 Polarity 同期信号の極性を選択します。NROM は黒
レベルが低いとき。INVERT は黒レベルが
高いときです。 

 Source トリガ信号源を CH1 または CH2 に設定しま
す。 

 Sync 同期のビデオ信号の部分を選択します。 
： line または field. 

トリガ極性の選択 F2（Polarity）キーを押し同期信号の極性を
選択します。 

• Normal: 黒レベルが低い場合 

• Inverted: 黒レベルが高い場合 

Normal
Polarity

Inverted

F2  

信号源チャンネル
の選択 

F3(Channel)キーを押し、トリガ信号源を
CH1 または CH2 に選択します。トリガチャ
ンネル表示はディスプレイ右下端に表示
されます。 

Trigger source 
channel  

CH1
Source

CH2

F3  

同期の選択 F4（Polarity）キーを押し同期ポイントを選
択します。 

• Line： ビデオラインを選択 

• Field： ビデオフィールドを選択 

Line
Sync

Field

F4  

Example 

ビデオライントリガ 

 

ビデオフィールドトリガ 
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アクイジションモードの選択 

概要 アクイジションモードは入力信号のサンプリング方法を選
択します。 

 Sample 波形データは等間隔でサンプリングされま
す。サンプルモードは正確に波形を再現し
ますが、急速な変化と突発のピークに応答
することはできません。 

 Peak detect サンプリング間の最大と最小データを取得
します。ピーク検出モードは急速な変化と突
然のピークを捕らえます。しかし波形はノイ
ズが多くなります。 

 Average 入力信号を平均化します。 

平均モードはランダムなノイズを低減するこ
とができます。しかし、入力波形は繰返しの
波形でなければなりません。 

平均回数：4、16、64、および 128 

パネル操作 1. MENU キーを押し Up/Down キーで
ACQU MODE メニューを選択しま
す。 MENU ACQU MODE

 

 2. アクイジションモードを
F1(Sample)から
F3(Average)で選択しま
す。 

Sample Peak
Detect Average

F1 F2 F3  

 平均モードでは F4（Average）キーを
押し平均回数を選択します。 

平均回数： 4, 16, 64, or 128. 

16
Averages

F4  

Example Sample 

 

Peak detect 

 

Average (16) 
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ディスプレイ設定 

概要 ディスプレイ設定はディスプレイに波形を表示する設
定をします。 

 vector  ベクトルモードは各データ間をスムース
な線で波形を表示します。 

 dot  ドットモードは、個々のデータをそのまま
表示します。 

 persistence 重ね書モードは、以前の波形を表示し
たまま新しい波形を重ねて表示します。
波形の変化を観測するのに便利です。 

パネル操作 1. MENU キーを押します。Up/Down キーで DISP 
SET メニューを選択します。 

2. F1（Type）キーでベクトルまたはドットを選択しま
す。 

3. F“（Persist）キーで重ね書の時間を選択します。 
範囲：1s、2s、無限 

MENU DISP SET Vectors
Type

Dots

F1

OFF
Persist

Infinite
1/2/5 sec

F2
 

Vector/dot 描画例 Vector 

 

Dot 

 

Persistence （重ね
書）例 

重ね書オフ 

 

重ね書 無限回 
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システム情報の表示 

概要 システム情報は本器のシステム設定状態を表示しま
す。 

パネル操作 1. MENU キーを押します。Up/ 
Down キーで SYS STAT 間ニュ
ーを選択します。 MENU SYS STAT

 

 2. F1（水平）から F4（Misc）のステータスメニューを選
択します。選択された情報がディスプレイに表示さ
れます。 

 Horizontal Vertical Trigger Misc

F1 F2 F3 F4  

 3. システム情報を閉じるには
MENU キーの Up/Down キーで
別のメニューを選択します。 MENU

 

 水平軸情報 (F1) 

HORI ZONTAL SYSTEM STATUS

TI ME BASE MAI N TI ME BASE
MAI N SCALE 1. 0ms
WI NDOW SCALE 10. us
MAI N POSI TI ON 300. 0us
WI NDOW POSI TI ON 559. 60us
DI SPLAY FORMAT YT
ACQUI RE MODE SAMPLE

 

各項目の詳細は以下のページを参
照ください。 

Time base:：22 ページ 

Main/window scale：43 ページ 

Main/window position：43 ページ 

Display format：45 ページ(XY) 

Acquire mode: 31 ページ 
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 垂直軸情報(F2) 

VERTI CAL SYSTEM STATUS

SCALE CH1 2. 00v
SCALE CH2 50. 0mv
POSI TI ON CH1 0. 00 di vs ( 0. 0mv)
POSI TI ON CH2 0. 00 di vs ( 0. 0mv)
COUPLI NG CH1 DC
COUPLI NG CH2 DC
PROBE CH1 1X
PROBE CH2 1X
MATH CH1-CH2
I NVERTED CH1 OFF
I NVERTED CH2 OFF

 

各項目の詳細は以下のページを参
照ください。 

CH1/CH2 scale：19 ページ 

CH1/CH2 position：19 ページ 

CH1/CH2 coupling：19 ページ 

CH1/CH2 probe：19 ページ 

Math mode：36 ページ 

CH1/CH2 invert：19 ページ 

 Trigger status (F3): Edge trigger 

TRI GGER SYSTEM STATUS

TYPE EDGE
SOURCE CH1
SLOPE RI SI NG
TRI GMODE SI NGLE TRI GGER
COUPLI NG DC

 

各項目の詳細は以下のページを参
照ください。 

Trigger type：26 ページ 

Trigger source：26 ページ 

Trigger slope：26 ページ 

Trigger mode：26 ページ 

Trigger coupling：26 ページ 

 Trigger status (F3): Video trigger 

TRI GGER SYSTEM STATUS

TYPE VI DEO
SOURCE CH1
POLARI TY NORMAL
SYNC LI NE

 

各項目の詳細は以下のページを参
照ください。 

Trigger type： 29 ページ 

Trigger source： 29 ページ 

Trigger polarity：29 ページ 

Trigger sync：29 ページ 

Misc status (F4)  
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MI SC

GW I NSTEK
Ser i es Number
W102206150095

 

 Misc 情報は製造者とシリアル番
号を表示します。  
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自動測定 

概要 測定機能は、波形の様々なパラメータを測定すること
ができます。 

測定項目 • 波形演算 

• 自動測定 

• 時間カーソル測定 

• 電圧カーソル測定 

36 ページ 

38 ページ 

39 ページ 

40 ページ 

波形演算の実行 

概要 波形演算機能は、CH1 と CH2 の波形を演算処理し
結果をディスプレイに表示します。 

演算形式 • CH1 ‒ CH2 (CH1 から CH2 を減算します) 

• CH2 ‒ CH1 (CH2 から CH1 を減算します) 

• CH1 + CH2 (CH1 と CH2 を加算します) 

• CH1 * CH2 (CH1 と CH2 を乗算します) 

• CH1 / CH2 (CH1 を CH2 で除算します) 

パネル操作 1. Ch1 と Ch2 の波形を同時に表示させます。 

 2. MENU キーを押します。Up/ 
Down キーを押しWAVE MATH
メニューを選択します。 MENU WAVE MATH

 

 3. 演算機能を F1 (CH1 ‒ CH2)から F5 (CH1 / CH2) 
で選択します。 

 
CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2 CH1/CH2

F1 F2 F3 F4 F5  

 4. 演算結果はディスプレイに表示されます。 
(例：2 つの方形波を加算) 



  オシロスコープを使用する。 

37 

 

 

 5. 演算結果を解除するには再度（F1 から F5）を押し
ます。 

演算結果の位置を
変更する。 

1. OSC OPTION キーを以下のメニュ
ーがディスプレイに表示されるまで
押します。 

OSC
OPTION

 

 LEFT/RIGHT ‒ Time 
UP/DOWN ‒ CHM Zero  

 2. 矢印キーで演算結果のポジション
を移動します。 

 

演算結果のスケー
ルを変更する。 

1. OSC OPTION キーを以下のメニュ
ーが表示されるまで押します。 

OSC
OPTION

 

 LEFT/RIGHT ‒ Time Base 
UP/DOWN ‒ CHM Vol  

 2. 矢印キーで演算結果のスケールを
変更します。 

 

演算結果の保存ま
たは読出し 

演算結果の波形は 4つの内部メモリに保存できま
た、読み出すことができます。 
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自動測定の実行 

概要 自動測定機能は入力信号の特性を測定し、ディスプ
レイの左上に表示します。 

信号源 CH1, CH2 

測定 set SET1, SET2 

測定項目 以下の測定項目が選択できます。 

• 周波数（Frequency） 

• 周期（Period） 

• 実効値（Mean voltage） 

• 最大値（Peak-to-peak voltage） 

• 真の実効値（Cycle voltage (true RMS)） 

パネル操作 1. 波形を表示させます。 

 2. MENU キーを押し Up/Down キ
ーで MEAS SET1 または MEAS 
SET2 メニューを選択します。選
択した測定項目はディスプレイ
右上端に表示されます。 

MENU
MEAS SET1

MEAS SET2

 

 MEAS SET1 MEAS SET2

MEAS SET2
MEAS SET1

Measurement items  

 3. 測定項目を F1 (Freq) から F5 (Cyc)で選択しま
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す。 

 

Period Mean Pk-Pk Cyc RMS

F1 F2 F3 F4 F5

Freq

f T V Vp VkTop left 
corner

 

 4. 測定結果はディスプレイの左上隅に表示されま
す。 

時間カーソル測定の実行 

概要 時間カーソル機能は以下の時間差の 3項目を測定し
ます。 

• カーソル 1 と 2 間 

• カーソル 1 と中央（ゼロ）間 

• カーソル 2 と中央（ゼロ）間 

1. 波形を表示します。 時間カーソルのパ
ネル操作 

2. MENU キーを押し Up/Down キ
ーで CURS MEAS メニューを選
択します。 MENU CURS MEAS

 

 3. F1（Type）キーで時間カーソル
を選択します。ディスプレイに紫
色の垂直カーソルが表示されま
す。（初期設定ではディスプレイ
の中央に表示されます） 

Time
Type

F1  

 4. OSC OPTION キーを押し下記
のメニューを表示させます。 

OSC
OPTION

 

 LEFT/RIGHT ‒ Time 

UP/DOWN ‒ Cursor 
1(or Cursor2) 

 

 5. 矢印キーでカーソルを移動させるか水平ポジショ
ンを移動させます。 
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 カーソルを
左へ移動

カーソルを
右へ移動

水平ポジションを

右へ移動

水平ポジションを
左へ移動

 

ディスプレイ表示 

(CH1, cursor 2) 

T1
カーソル

T2 - T0間の時間
T1 - T0
T1 - T2

& 周波数
カーソル2 メニュー

T0
( 中央 )

T2
カーソル

 

電圧カーソル測定 

概要 電圧カーソル機能は以下の電圧差の 5項目を測定し
ます。 

• カーソル 1 と 2 間 

• カーソル 1 と CH1 マーカ間 

• カーソル 2 と CH1 マーカ間 

• カーソル 1 と CH2 マーカ間 

• カーソル 2 と CH2 マーカ間 

ソース信号 CH1 入力, CH2 入力 

電圧カーソルのパ 1. 波形を表示します。 
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ネル操作 2. MENU キーを押し Up/Down キ
ーで CURS MEAS メニューを表
示させます。P MENU CURS MEAS

 

 3. F1(Type)キーで電圧カーソルを
選択します。カーソルは紫色の
水平線で表示されます。（初期
設定ではディスプレイの中央に
表示されます） 

Voltage
Type

F1  

 4. F2(SOURCE)キーで信号源チャ
ンネルを選択します。 

CH1
Source

F2  

 5. OSC OPTION キーを押し以下
のメニューを表示させます。 

OSC
OPTION

 

 LEFT/RIGHT ‒ Time 

UP/DOWN ‒ Cursor V1 
(or Cursor V2) 

 

 6. 矢印キーでカーソルまたは水平ポジションを移動さ
せます。 

 

OSC
OPTION

カーソルを
上へ移動

カーソルを
下へ移動

水平ポジションを
左へ移動

水平ポジションを
右へ移動
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ディスプレイ表示 

(CH1, cursor 2) 

V2 - center
V1 - center

|V1 - V2|

カーソル2
メニュー

V1
カーソル

V2
カーソル
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機能 

概要 高度な観測機能は、波形の特性や特定の場所を観測
するのに便利です。 

項目について • 拡大機能（Waveform zoom） 

• X-Y 

• 信号ピーク 

• ノイズ信号 

• 信号の変化 

43 ページ 

45 ページ 

46 ページ 

46 ページ 

47 ページ 

水平方向拡大 

概要 拡大機能を使用することで水平方向に波形を拡大す
ることができます。 

パネル操作 1. ディスプレイに波形を表示させます。 

 2. MENU キーを押します。Up/ 
Down キーで TIME MODE を選
択します。 MENU TIME MODE

 

 3. F2（Zone Window）を押します。
カーソルセットが表示されます。
（初期設定ではディスプレイの
中央に表示されます） 

Zone
Window

F2
 

 Zoom window
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 4. OSC OPTION キーを Time 
Base が表示されるまでになる
まで押します。 

OSC
OPTION

 

 Cursor 1 メニュー 

 

 5. 矢印キーで拡大範囲を変更します。U 

 

OSC
OPTION

Zoom out
垂直軸スケール

Zoom in
垂直軸スケール

範囲拡大範囲縮小

 

 6. F3(Window)を押しウィンドウを 
拡大します。 Window

F3
 

例： 

Zoom window
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X-Y 動作での波形観測 

概要 X-Y 表示は、CH1 入力を X軸、CH２入力を Y軸とし
て表示します。ディスプレイモードは CH1 と CH2 の間
の位相観測に便利です。 

パネル操作 1. CH1 と CH2 の波形を表示させます。 

 2. MENU キーを押します。
Up/Down キーで DISP SET メ
ニューを選択します。 MENU DISP SET

 

 3. F3(Format)を押し XY を選択し
ます。ディスプレイモードは XY
表示に変わります。 

XY
Format

F3  

スケールをポジショ
ンの変更 

OSC OPTION キーを下記のメニューが
表示されるまで押します。X-Y モードでは
全てのスケールとポジションは Up/Down
キーでコントロールします。 

OSC
OPTION

 

 • CH1 Zero： 水平ポジション 

• CH2 Zero： 垂直ポジション 

• CH1 Vol： 水平スケール 

• CH2 Vol： 垂直スケール 

X-Y モードで使用で
きない機能 

以下の機能は X-Y では動作しません。 

• カーソル測定 (39 ページ, 40 ページ) 

• 自動測定(38 ページ) 

• 拡大機能 (43 ページ) 

• トリガ設定状態 (23 ページ) 
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信号ピークの観測 

概要 ピーク検出機能を使用するとサンプリング毎に最大と
最小データが表示されます。波形の急速な変化や突
発なピークを捉えて表示することができます。 

注意 ピーク検出モードでは、最大・最小値を表示するため
波形はノーマルモード(sampling mode)よりノイジーに
なります。 

パネル操作 1. MENU キーを押します。Up/Down キーで ACQU 
MODE メニューを選択します。 

2. F2（Peak Detect）キーを押しピーク検出モードを選
択します。 

MENU ACQU MODE Peak
Detect

F2
 

そのほかのアクイジションモードについては 26 ページ
を参照ください。 

例 

ピーク検出 オフ 

 

ピーク検出 オン 
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ノイズ信号の観測 

概要 平均モードを選択することで複数回の平均をすること
でノイズの無いきれいな波形を観測することができま
す。平均回数は 4、16、64 と 128 回から選択します。 

注意 • 平均モードを使用する場合は、繰り返し波形でな
いといけません。 

• 平均回数が大きくなると波形の更新が遅くなりま
す。 

パネル操作 1. MENU キーを押します。Up/Down キーで ACQU 
MODE を選択します。 

2. F3（Average）キーを押し平均モードを有効にしま
す。 

3. F4（Average）を押し平均回数を選択します。 

MENU ACQU MODE Average 16
Averages

4
128
64

F3 F4
 

そのほかのアクイジションの詳細については 26 ペー
ジを参照ください。 

例 

Average オフ 

 

Average 16 
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信号の観測 

概要 重ね書機能は、以前の波形を表示することで波形の
変化を観測することができます。重ね書の時間は 1
秒、2 秒 5 秒と無限回から選択できます。 

パネル操作 1. MENU キーを押します。Up/Down キーで DISP 
SET メニューを選択します。 

2. F2(Persist)キーを押し、重ね書時間を選択します。 

MENU DISP SET OFF
Persist

Infinite
1/2/5 sec

F2
 

その他の表示設定については 32 ページを参照くださ
い。 

例 

重ね書 オフ 

 

重ね書 無限回 
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校正 

概要 校正については、自己校正機能とプローブ補正の 2
種類があります。 

自己校正は自動的に本器の内部パラメータを調整し
ます。 

プローブ補正はプローブの特性を調整します。新たな
環境で使用する場合は必ず 2種類の校正を実行して
ください。 

自己校正の実行 

概要 自己校正機能は感度と確度を維持するために内部パ
ラメータを設定します。以下の場合に自己校正を実行
します。 

• 使用中に温度が 5℃以上変化した場合。 

• 新しい環境やしばらく操作しなかった場合。 

手順 1. MENU キーを押します。
Up/Down キーで FUNCTION メ
ニューを選択します。 MENU FUNCTION

 

 2. F2（Autocalibration）キーを押し
ます。本体から全てのケーブ
ル、プローブを取り外すようメッ
セージが表示されます。 

Autoca
libration

F2
 

Self Calibration
Remove all probes & 
cables from (CH1 CH2)
Press <Do Self Cal> for 
Calibration
Press any key to quit

 

 3. すべてのケーブルを取り外した
後、F2(Autocalibration)を再び
押します。自己校正が自動的に
起動し進行中のマークが表示さ
れます。 

Autoca
libration

F2
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Autoca lib rat io n
.. ..

 

 4. 約 5分でメッセージが消え校正が終了します。 

校正を中止するに
は 

自己校正が進行中にいずれかのキーを押してくださ
い。 

プローブ補正 

概要 付属のプローブを使用する場合は使用する前に、プロ
ーブ補正を必ず実行してください。 

手順 1. 本体上部のコネクタ端子に付属の
ケーブルを挿入します。 

   白   ピンク 

 

 

 2. ケーブルにプローブを接続します。  
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 3. 補正用信号として方形波を選択し
ます。オートセット機能を使い、波形
をディスプレイの中央にします。 

AUTOSET
 

 

 

 4. プローブにある補正用トリマを調整に方形波を平
坦にします。 

 

 過補正 適正 不足 
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保存/読出し 

概要 本器は、波形保存用に 4つの内部メモリを持っていま
す。波形は、保存/読出しが可能です。また、本器を初
期設定（工場出荷時）にリセットすることが出来ます。 

Save/recall 項目 • 初期設定（工場出荷時）にする。 

• 波形を保存する。 

• 波形を読み出す。 

52 ページ 

53 ページ 

54 ページ 

リセット（初期設定）読出し 

初期設定にする。 初期設定（工場出荷時）にするにはMENU キーを押し
次に Up/Down キーで FUNCTION を選択します。
F1(Recall Factory)キーを押すと初期設定（工場出荷
時）にリセットされます。 

FUNCTION Recall
Factory

F1

MENU

 

Trigger Type: Edge 

Source: CH1 

Coupling: AC 

Slope: 立上り 

Mode: Auto 

CH1 & CH2 Coupling: AC 

Probe 減衰率： 1 X 

Channel: ON 

Invert: OFF 

Measurement 1 項目： CH1 の周波数  

Measurement 2 項目： CH2 の周波数  

Cursor カーソル： OFF チャンネル： CH1 

Acquisition Mode: Sample Average number: 16 

Time mode Mode: Main timebase  

Display タイプ： Vector 

Format：YT 

Persistence： OFF 

Carry： Bitmap 

Wave Save Source： CH1 

Display：OFF 

Waveform：A 
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波形の保存 

概要 波形を 4 つまでメモリに保存/読出しできます。保存し
た波形はリファレンス、比較用として使うことができま
す。 

メモリ 4 メモリ：WAVE A～D 

保存元波形 CH1, CH2, Math waveform 

パネル操作 1. 保存したい波形（CH1、CH2、または MATH）をディ
スプレイに表示させます。MATH 操作の詳細は 36
ページを参照ください。 

 2. MENU キーを押します。
Up/Down キーで WAVE SAVE
メニューを選択します。 WAVE SAVEMENU

 

 3. F1(Souece)キーを押し、保存し
たい元波形を選択します。 

CH1
Source

F1  

 4. F2(WAVE)キーを押し保存先メ
モリ A から D を選択します。 

A
Wave

F2  

 5. F3(Save)キーを押すと保存を実
行します。保存が完了する
と”WAVE SAVED”のメッセージ
が表示されます。 

Save

F3  

 WAVE SAVE SUCCEEDED  
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波形の読出し 

概要 保存された 4 つの波形を読み出すことができリファレ
ンスや比較波形として使用できます。 

メモリ 内部メモリ 4 つ：WAVE A～D 

ソース CH1, CH2, Math waveform 

パネル操作 1. MENU キーを押します。
Up/Down キーで WAVE SAVE
メニューを選択します。 WAVE SAVEMENU

 

 2. F2(Wave)キーを押し読み出した
いメモリ（A～D）を選択します。 

A
Wave

F2  

 3. F4 を押すと波形がディスプレイ
に表示されます。 

ON
CH A

F4  

 

 

注意 読出した波形は、保存したときの水平・垂直スケール
（ディスプレイに表示されます）で表示されます。現在
のスケール設定を変更しても変わりません。 
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メニューツリー / 操作のショートカット 

メニュー操作 以下のメニューツリーは、OSC (59 ペー
ジ)OPTION キーを除いてMENU キーを
押すことで選択できます。 MENU

 

トリガ（Trigger） 

Edge
TYPE

Falling
Slope

CH1
Source

Single
Mode

DC
CouplingTRIG MODE

Video
TYPE

Normal
Polarity

CH1
Source

Line
Sync

Rising CH2
Auto

Normal

AC
LF Rjc
HF Rjc

Inverted FieldCH2

RUN/STOP

F1 F2 F3 F4 F5

F1 F2 F3 F4  

RUN または STOP の選択 RUN/STOP key 

エッジまたはビデオトリガの選択 TRIG MODE→F1(TYPE) 

トリガスロープの選択 TRIG MODE→F1(edge)→F2(Slope) 

トリガソースの選択 TRIG MODE→F1→F3(Source) 

トリガモードの選択 TRIG MODE→F1(edge)→F4(Mode) 

トリガ結合の選択 TRIG MODE→F1(edge)→F5(Coupling) 

ビデオ極性の選択 TRIG MODE→F1(video)→F2(Polarity) 

ビデオライン同期 TRIG MODE→F1(video)→F4(Sync) 
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CH1/CH2 の設定 

AC
Coupling

ON
Channel

1 X
Probe

OFF
InvertedCH2 SETUP

OFF

1000 X
100 X
10 X ONDC

CH1 SETUP

F1 F2 F3 F4  

AC、DC、Ground の選択 CH1/2 SETUP→F1(Coupling) 

CH1 表示の ON/OFF CH1/2 SETUP→F2(Channel) 

プローブ減衰率の選択 CH1/2 SETUP→F3(Probe) 

波形反転のON/OFF CH1/2 SETUP→F4(Inverted) 

自動測定（MEAS Set1） 1/2 

Freq Period Mean Pk-PkMEAS SET2

CH2
CH1

MEAS SET1

Cyc RMS

CH2
CH1

CH2
CH1

CH2
CH1

CH2
CH1

F1 F2 F3 F4 F5  

CH1 または CH2 周波数測定 MEAS SET1/2→F1(Freq) 

CH1 または CH2 周期測定 MEAS SET1/2→F2(Period) 

CH1 または CH2 実効値 MEAS SET1/2→F3(Mean) 

CH1 または CH2Peak-Peak 電圧 MEAS SET1/2→F4(Pk-Pk) 

CH1 または CH2 真の実効値 MEAS SET1/2→F5(Cyc RMS) 

波形演算（Wave Math） 

CH1-CH2 CH2-CH1 CH1+CH2 CH1*CH2WAVE MATH CH1/CH2

F1 F2 F3 F4 F5  

減算：CH1-CH2 WAVE MATH→F1(CH1-CH2) 

減算： CH2 ‒CH1 WAVE MATH→F2(CH2-CH1) 

加算：CH1+Ch2 WAVE MATH→F3(CH1+CH2) 

乗算： CH1×CH2 WAVE MATH→F4(CH1*CH2) 

除算： CH1/ CH2 WAVE MATH→F5(CH1/CH2) 
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カーソル測定（CCURS MEAS） 

OFF
Type

CH1
SourceCURS MEAS

Time
Voltage CH2

F1 F2  

カーソル測定のON/OFF と TIME/VOLTAGE

の選択 

CURS MEAS→F1(Type) 

ソースチャンネルの選択 CURS MEAS→F2(Source) 

アクイジションモード 

Sample Peak
DetectACQU MODE Average 16

Averages

4
128
64

F1 F2 F3 F4  

Sample モードを選択 ACQU MODE→F1(Sample) 

ピークモードを選択 ACQU MODE→F2(Peak Detect) 

平均モードを選択 ACQU MODE→F3(Average) 

平均回数を選択 ACQU MODE→F3→F4(Averages) 

時間軸モード（Time Mode） 

Main
TimeBase

Set
WindowTIME MODE Zone

Window

F1 F2 F3  

timebase を選択（通常） TIME MODE→F1(Main TimeBase) 

拡大範囲（Zone Window）を選択 TIME MODE→F2(Set Window) 

拡大（window）を選択 TIME MODE→F3(Zone Window) 

ファンクション（Function） 

Recall
Factory

Do
Self CalFUNCTION 中文

Language

F1 F2 F3  

初期設定を読み出す。 FUNCTION→F1(Recall Factory) 

自己校正を実行 FUNCTION→F2(Do Self Cal) 
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ディスプレイ 

Vectors
Type

OFF
PersistDISP SET YT

Format
Bitmap
Carry

Dots

Infinite
5 sec
2 sec
1 sec XY Vectors

F1 F2 F3 F4  

アクイジションの設定（ベクトルまたはドット） DISP SET→F1(Type) 

重ね書の ON/OFF DISP SET→F2(Persist) 

通常/X-Y モードの選択 DISP SET→F3(Format) 

画面保存フォーマットの選択（J-PEG または

BMP） 

DISP SET→F4(Carry) 

波形保存（Wave Save） 

CH1
Source

A
WaveWAVE SAVE Save OFF

CH

Math OFF
CH2

D
C
B ON

F1 F2 F3 F4  

保存チャンネルの選択 WAVE SAVE→F1(Source) 

内部メモリ番号の選択（Aから D） WAVE SAVE→F2(Wave) 

保存を実行する。 WAVE SAVE→F3(Save) 

メモリ波形のON/OFF（F2 のメモリ番号） WAVE SAVE→F4(CH A/B/C/D) 

システム情報 

Horizontal VerticalSYS STAT Trigger Misc

F1 F2 F3 F4  

水平軸設定の表示 SYS STAT→F1(Horizontal) 

垂直軸設定の表示 SYS STAT→F2(Vertical) 

トリガ設定の表示 SYS STAT→F3(Trigger) 

シリアル番号の表示 SYS STAT→F4(Misc) 
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OSC OPTION キー 

OSC
OPTION

UP

DOWN

RIGHTLEFT

 

OSC OPTION キーを押す度にメニューメッセー
ジがディスプレイ左下に表示され変わります。
表示されたメッセージの機能は UP、DOWN、
RIGHT、LEFT キーで選択します。 

 

 

LEFT/RIGHT: CH1/CH2 水平トリガ位置 

UP/DOWN: CH1 垂直ポジション 

LEFT/RIGHT: CH1/CH2 水平スケール 

UP/DOWN: CH2 垂直ポジション 

LEFT/RIGHT： CH1/CH2 水平位置 

UP/DOWN:トリガ位置（垂直） 

LEFT/RIGHT: 水平スケール（Time/div） 

UP/DOWN: CH1 垂直スケール（Volts/div） 

LEFT/RIGHT - Time
UP/DOWN - CH1 Zero

LEFT/RIGHT - Time
UP/DOWN - CH2 Zero

LEFT/RIGHT - Time
UP/DOWN - Trig

LEFT/RIGHT - Time Base
UP/DOWN - CH1 Vol

LEFT/RIGHT - Time Base
UP/DOWN - CH2 Vol

 

LEFT/RIGHT: 水平スケール（Time/div） 

UP/DOWN: CH2 垂直スケール（Volts/div） 

(Math mode) 

LEFT/RIGHT ‒ Time 

UP/DOWN ‒ CHM Zero 

(Math モード) 

LEFT/RIGHT: Math 水平ポジション 

UP/DOWN: Math 垂直ポジション 

(Cursor mode) 

LEFT/RIGHT ‒ Time 

UP/DOWN ‒ Cursor 1/2 

(カーソルモード) 

LEFT/RIGHT: CH1/CH2 水平ポジション  

UP/DOWN: Cursor 1/2 垂直ポジション 
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ソフトウェアについて 

概要 付属 CD-ROM に入っている PC ソフトウェアは PCの
画面で波形を観測することができます。 

ソフトウェアの機能 PC ソフトウェアには下記の機能があります。 

• リアルタイムの波形更新 

• 6 個のカーソル測定 

• 周期/周波数/Peak-Peak/電圧測定 

• 波形画像の印刷 

• 波形の保存 

ソフトウェアの操作 以下はソフトウェアの操作方法について説明している
項です。 

 • ソフトウェアのインストール 

• 変更、再インストール、削除につい
て 

• GDS-122 との接続 

• PC画面の設定 

• 波形の観測 

• 波形の測定 

• 波形の保存 

• 波形の読出し 

• 波形の印刷 

• ヘルプ 

61 ページ 

63 ページ 
 

64 ページ 

67 ページ 

69 ページ 

74 ページ 

74 ページ 

77 ページ 

80 ページ 

82 ページ 

注意 本 PC ソフトウェアはオシロスコープ機能のみコントロ
ールします。マルチメータ機能には対応しておりませ
ん。 
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ソフトウェアのインストール 

PC の仕様 • Windows 2000 または Windows XP上で稼動 

• ハードディスクの空き容量：20MB 以上 

• USB ホストポート x 1（付属専用ケーブルを使用） 

インストール手順 1. CD-ROM の”Set-up.exe”を起動し
ます。 

 

 2. Welcome ウィンドが表示されます。NEXT を選択し
て PCにインストールが開始されます。 

 

 

 3. インストールするディレクトリを変更する場合は
「CHANGE」を押し変更します。 
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 4. Install をクリックしソフトウェアをインストールしま
す。 

 

 

 5. ソフトウェアは自動的に開始し終了します。終了す
ると Finish メッセージが表示されます。 

 

 

ソフトウェアのインストールが完了しました。 
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ソフトウェアの変更および再インストールと削除 

概要 ソフトウェアのインストールが終了したら同じセットアッ
プファイルから以下が実行できます。 

• ソフトウェアの変更 

• ソフトウェアの修正 

• ソフトウェアの削除 

手順 1. Setup.exe を起動します。インスト
ールと同様の手順で Program 
Maintenance ウィンドが表示される
まで進みます。 

 

 

 

 2. 機能を選択します。  
Modify：ソフトウェアの変更項目を選択します。修
正：ソフトウェアの修正 
削除：ソフトウェアの削除 
を選択し Next をクリックします。  

削除 削除にはWindows のスタートからプログラムを選択し
Uninstall DS_WAVE を選択するか、コントロールパネ
ルの「プログラムの追加と削除」から選択する方法が
あります。 
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ソフトウェアの実行と GDS-122 との接続 

概要 ソフトウェアを起動します。次に説明する手順の後に
GDS-122 と接続します。 

1. ソフトウェアを起動し、COM ポートの設定をしま
す。 

2. GDS-122 の電源をオンにしてデータフォーマットを
設定します。 

3. PC と GDS-122 を接続します。必要であれば USB
ドライバをインストールします。 

 
 

ドライバは、解凍したフォルダの USBDRV にありま

す。 

 

正常に通信できるか確認するために波形データを取
得します。 

データの取得については、69 ページを参照してくださ
い。 

ソフトウェアを使用
する 

1. Windows のスタートからすべ
てのプログラムを選択し次に
DS_Wave.exe を選択しソフト
ウェアを起動します。 

 

 2. メニューまたはツールバーに
あるポート設定アイコンから
COM ポート設定を選択しま
す。 
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 3. USB 接続が選択されていることを確認します。 
ボーレート、ストップビット、データビットおよび 
パリティの設定は固定です。 

 

 

GDS-122 を起動す
る。 

1. GDS-122 の電源を ON にし、オシロスコープ画面
を表示させます。 

 2. CH1 に信号を入力し波形が表示されていることを
確認します。 

 3. DISP SET メニューを表示さます。GDS-122 から
PCへ波形データが送れるように F4(Carry)キーで
フォーマットを選択します。 

 

MENU DISP SET Bitmap
Carry

Vectors

F4
 

 Vectors 波形のベクトルデータ。ソフトウェアで波
形観測するには常に Vector フォーマット
を選択してください。 

 Bitmap ディスプレイのビットマップイメージです。
GDS-122 の画面のビットマップのスナッ
プショットを取得する場合のみ Bitmap 
フォーマットに設定します。 
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ケーブルの接続 1. GDS-122 と PC（ソフトウェア）を付属の USB ケー
ブルで接続します。 

 2. USB ドライバがインストールされていることを確認
します。確認するにはWindows の「スタート」から
「コントロールパネル」のハードウェアにあるシステ
ムのハードウェアタグにあるデバイスマネージャを
選択しヒューマンインターフェースデバイスに下記
の表示があることを確認します。 

 

 

 3. ドライバが認識されていな
い場合、手動で USB ドライ
バをインストールしてくださ
い。 

 

 ドライバのファイルはインストールしたフォルダの
USBDRV フォルダにあります。 

データの取得 ソフトウェアでは、メニューから
Communications の Get Data
を選択します。または、Get 
Data アイコンまたは Ctrl + A
キーで選択することもできま
す。 

 

 

 GDS-122 ディスプレイスナップショットの取得 

GDS-122 で Bｉｔmap フォーマットが選択されていると
き、ディスプレイのスナップショット（*.bmp）を取得し保
存することができます。 

 GDS-122 波形データの取得  

GDS-122 で”Vectors”フォーマットを選択していると
PC ソフトウェアは波形データ（*ｂin）を取得することが
できます。 

 1. 波形データは、PCに保存されます。 
保存場所を選択し START をクリックします。 
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 2. 波形がソフトウェアの画面に表示されます。 

 

 

ソフトウェアの設定完了。 

画面の設定 

概要 この章では、ソフトウェア画面（waveform viewing 
mode ）パラメータの設定方法を説明します。 

 • 背面カラー 

• グリッドカラー 

• グリッド表示のON/OFF 

• 描画フォーマット 

• 言語 

• ソフトウェアの終了 

スクリーン外観  
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ツールバー
とアイコン

垂直軸スケールWaveform
リスト

カーソルの種類

測定結果

CH2

CH1

File location モデル名

水平時間

 

背面カラーの変更 背面カラーの変更にはメニューか
ら View > Background Color を選択
しカラーパレットから色を選択しま
す。画面内をダブルクリックするこ
とでもカラーパレットが表示されま
す。  

 背景色：黒 

 

背景色：白 

 

グリッド表示の
ON/OFF 

グリッド表示のON/OFF をするに
はメニューから View > Grid lines を
選択するかグリッドラインアイコンを
クリックします。 

 

 

 グリッド表示 on 

 

グリッド表示 off 
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グリッドカラーの変
更 

グリッドが表示されていることを確
認します。メニューから View > Grid 
Color を選択しカラーパレットが表
示されたら色を選択します。  

 

 青色グリッド 

 

白色グリッド 

 

波形描画フォーマッ
トの変更 

波形描画は、ラインとドットの 2種類のフォーマットか
ら選択できます。メニューから Format > Data Line 
(Point)を選択するかアイコンをダブルクリックします。 

 補間：ライン 

  

 

補間：なし 

  

 

ソフトウェアの終了 ソフトウェアを終了するには以下の方法があります。
画面の設定は保存され、次回ソフトウェアを実行する
ときも有効になります。 
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プログラムを終了す
る。 

• メニューの File > Exit を選択しま
す。 

 

ショートカットキー • Alt + F4 キーを押します。  

 • ウィンドの右上にある閉じるアイコ
ンをクリックします。  

波形の観測 

概要 この章では、より波形を見易くするようにする方法を説
明します。 

 • 表示されている波形を選択します。 

• 波形を更新します。 

• 有効な波形を選択します。 

• 波形ポジションを変更します。 

• 波形スケールを変更します。 

• 自動測定の結果を観測します。 

画面の外観  
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波形リスト

CH2

CH1

有効波形

測定結果

垂直軸スケール

水平時間

 

表示波形を選択し
ます。 

画面の左下の枠にあるボックスから表示したい波形
にチェックマークを入れます。最大 6個の波形が表示
できます。CH1、CH2、A、B、C、D。 
波形 A から Dは GDS-122 に事前に保存してあるも
のです。詳細は 53 ページを参照ください。 

CH1, CH2 を選択 

 

波形の更新 ソフトウェアではメニューの
「Communications」→「 Get Data」
で波形が更新されます。同様に
Get data アイコンまたはショートカ
ットキー「Ctrl」+「A」でも更新できま
す。 

 

アクティブな波形の
選択 

波形スケール設定と自動計測は、有効な波形が対象
となります。 

 1. 画面の右下にある波形番号にチェックを入れま
す。 

(有効な波形として CH1 を選択します。) 
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 2. 選択したチャンネルによって以下の環境が変更さ
れます。(例： CH1). 

 • チャンネルラベルのカラー(画
面の左側)  

 • カーソル、水平時間、電圧設
定(画面の右側) 

 

 

 

 • 自動計測の結果(画面の右下) 

 

波形ポジションの 
変更 

水平ポジションの変更 

1. マウスアイコンが⇔矢印に変わるまで波形の上に
マウスを移動します。 

注意： 

Auto Get Data モードではスケールの変更はできませ
ん。「STOP」を押してください。 

 

 

 2. その状態でマウスを Hold し波形を左右へ移動さ
せます。 
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 垂直ポジションの変更 

波形の左にあるチャンネルラベルをクリックし上下にド
ラックし移動します。 

 

 

波形スケールの 
変更 

スケースを変更する前に画面左下で選択している波
形を確認します。（選択色になっている）(例： CH1). 

 

 

 水平スケールの変更 

 画面右にあるリストボックスから水
平スケールを選択します。スケー
ルはポジション矢印をクリックする
ことでも変更できます。 

 

 

 

 

 

 

 

 

 垂直スケールの変更 
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 画面右のリストボックスから垂直
スケールを選択することができま
す。また、ポジション矢印をクリック
することでも変更できます。 

 

 

 

 

 

 

 

 

自動計測結果の観
測 

自動計測の結果を観測する前に画面左下で選択して
いる波形を確認します。（選択色になっている） (例： 
CH1). 

 

 

 測定結果は画面右下に更
新されます。3 種類のパラ
メータが表示されます。 

 

 • 周期：波形の周期を[ms]で測定します。 

• 周波数：波形の周波数を[kHz]で測定します。 

• PK-PK: 電圧を[V]で測定します。 

カーソル測定 

概要 この章では、ソフトウェア画面でのカーソル測定につ
いて説明します。 

注意： 

Auto Get Data モードではカーソルの変更はできませ
ん。「STOP」を押してください。 
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 • カーソルを有効にする。 

• カーソル測定結果を観測する。 

• カーソルを移動する。 

画面の外観  

測定結果

水平カーソル

垂直カーソル

カーソルタイプ

 

カーソルを有効にす
る 

カーソルを有効にする前に画面左下で選択している
波形を確認します。（選択色になっている） (例： CH1). 

 

画面の右側にあるカーソルを選択します。 

 • なし：カーソルは OFF 
 

 • 水平：水平カーソルが表示され
ます。  

 • 垂直：垂直カーソルが表示され
ます。  

 • 全て：水平、垂直カーソルが同
時に表示されます。  
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カーソル測定結果
の観測 

カーソル測定結果は画面右側
に更新されます。 

• dy：ｙ１カーソルと y2 カーソル
間の電圧差 

• y1, y2： 電圧カーソル 1 と 2
の電圧（チャンネルラベルを
“0”） 

• dx： ｘ1 カーソルとｘ2 カーソ
ルとの時間差 

• x1, x2：時間カーソル 1 と 2  

 

0.0V

y1

y2

dy

x1 x20.0s

dx

 

カーソルの移動 マウスアイコンが⇔矢印に変わるまでカーソルの上に
移動します。ハウスを HOLD しカーソルを左右（水平
カーソル）や上下（垂直カーソル）に移動します。 

 

 

カーソル測定の結果が変わります。 



  オシロスコープを使用する。 

77 

波形の保存 

概要 PC に 2 種類の方法で波形を保存できます。読出しの
詳細については 79 ページを参照ください。 

• 波形データの保存(ファイル形式；*.bin,ソフトウェア
表示用フォーマット) 

• ポイントデータの保存(ファイル形式；*.txt,グラフな
どで詳細を観測用) 

GDS-122 に波形を保存する方法については 53 ペー
ジを参照してください。 

波形データの保存 GDS-122 から波形データを取り出すとき、波形データ
(*.bin フォーマット)は自動的に保存されます。69 ペー
ジ 

ポイントデータの保
存 

1. 画面に表示されている波形を確認します。PCに保
存されている波形を読み出すには 79 ページを参
照してください。 

 2. メニューから View > Data Table を
選択します。ツールバーDATA 
Table アイコンをクリックします。デ
ータ表のダイアログが表示されま
す。 

 

 

 

閉じる

Saveデータ

Saveオプショ
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 3. Save の列から保存したいデータを
選択します。 

• シーケンス：各データの識別番号 

• ch1/ch2： CH1 と CH2 波形データ 

• A/B/C/D： GDS-122 の本体に保
存してある波形。 

 

 Microsoft® Excelで表示した場合の例 

シーケンス ch1 / ch2 A / B / C / D

 

 4. Save As をクリックする。 
直接データを保存するボタン
Windows 標準の保存ダイアログが
表示されます。 

 

 5. データポイントダイアログを閉じるには以下を実行
してください。 

• Ctrl + Alt キーを押します。 

 • Exit アイコンを押します。 

 

 • ダイアログ右上にある閉じるアイコ
ンをクリックします。  
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波形の読出し 

概要 PCから波形を読み出すには 2種類の方法がありま
す。保存方法の詳細については 77 ページを参照くだ
さい。 

• 波形データを読み出します。  
ファイル形式：*.bin 、PC ソフトウェア専用 

• ポイントデータを読み出す 
ファイル形式：*.txt 、グラフなどデータ解析に使用
できます。 

GDS-122 から波形を読み出すには 54 ページを参照く
ださい。 

波形データの読み
出し 

1. メニューから File > Open を選
択するか、ショートカットキー
Ctrl + O を押します。   

 2. 「ファイルを開く」のダイアログが開きます。SPB bin
ファイルのいずれかを選択し「OK」をクリックしま
す。 

 3. 画面に波形が読み出されます。 

 

 

データポイントの読
み出 

1. データポイントを読み出すにはテキストエディタを
開くかマイクロソフト エクセルのような計算ソフト
で開きます。データの解析やグラフなのができま
す。 

 2. アプリケーションから保存してある”＊.txt”を開く。 
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波形の印刷 

概要 PC に接続したプリンタに画面を印刷することができま
す。最初に波形を印刷するとき以下の手順を実行して
ください。 

1. プリンタの設定 
2. ページ設定 
3. 印刷 

プリンタの設定 1. メニューバーの File > Printer 
Setup を選択します。ウィンドウ
ズ標準のプリンタ設定ダイアロ
グが開きます。 

 

 2. プリンタを選択しプロパティ、用紙サイズなどを設
定します。 

ページ設定 1. メニューバーの File > Page 
Setup を選択します。「Page 
Setup」ウィンドウが開きます。 

 

 

Borderline

View Setting

 

 2. 余白を設定します。範囲：0～10.0cm 
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 3. 印刷の設定 Select the View Setting. 

サンプルデータから
グラフを再描画す
る。 

GDS-122 は、波形を更新し印刷前にスケールを調
整します。最新のデータが取得されますが時間が
掛かります。 

グラフの拡大/縮小 既存の波形は、元のスケールで使われます。デー
タ取得がないので、速い印刷が可能です。 

 4. メニューバーにある File > Print 
Preview を選択するか、ツール
バーにある Print Preview アイコ
ンをクリックして印刷プレビューを
開きます。 印刷する波形が適切
に表示されていることを確認しま
す。 

 

 

印刷出力 下記の手順に従って印刷出力します。 

 • 印刷プレビューメニューの印刷
(Print)を選択します。 

 

 • ソフトウェアメニューから File > 
Print を選択します。 

 

 • ショートカットキーCtrl + P を押します。 

 • ツールバーのプリンタアイコンを
押します。  
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ヘルプについて 

概要 ヘルプには、インストール方法とソフトウェアの使用方
法が載っています。About はソフトウェアのバージョン
が表示されます。 

ヘルプを開く 以下の方法の 1つを使って、別個のファイルの中でヘ
ルプをオープンします。 

 • メニューから Help > Help を選択
します。 

 

 • ツールバーの Help アイコンをク
リックします。  

 • ショートカットキーF1 を押します。  

 • スタートメニューから Help を開きます。 

 

システム情報の 
表示 

ソフトウェアのバージョンを見るには
メニューバーの Help > About を選
択するとシステム情報が表示できま
す。 
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マルチメータ機能を使う 

この章では、マルチメータ機能の主要な電圧、電流、イン
ピーダンスとダイオード、導通テスト、キャパシタンスにつ
いて説明しています。大電流と小キャパシタンスを測定す
るための拡張モジュールを使用した電流測定とキャパシ
タンスについても説明しています。デルタ測定と自動レン
ジ機能は、測定に便利です。 

マルチメータを起動する。 .................................................. 84  
電圧測定 ...................................................................... 85  
電流測定 ...................................................................... 87  
抵抗測定 ...................................................................... 89  
Diode 測定 .................................................................... 90  
導通チェック .................................................................. 92  
キャパシタンスの測定 ...................................................... 93  
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マルチメータを起動する。 

パネル操作 1. 電源スイッチを ON にします。ディスプ
レイにロゴが表示され welcome 画面
が出ます。 

 

 2. ディスプレイの輝度を調整するには本
体側面のボタンを押します。押すたび
に「明るい」「暗い」を繰り返します。 

 

 3. いずれかのキー（例：MENU キー）を
押しディスプレイを有効にします。ディ
スプレイ左上のバッテリーアイコンで
バッテリーのレベルが表示されます。 

例： 

MENU
 

 > 75% 

 

75% 

 

50% 

 

25% 

 

< 25% 

 

 オシロスコープの画面が表示されたら
DMM/OSCキーを押しマルチメータモ
ードに変更します。 

DMM/OSC
 

 4. A (current)、 V (voltage)または
R(impedance、 diode、 continuity
（capacitance)キーを押します。接続
確認のメッセージが表示されます。 

A

V

R  

 

Plug the Multimeter 
test leads in the
right position!

(Press any key to make sure)

 

 5. いずれかのキーを押し警告メッセージを解除して
測定を開始します。 
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電圧測定 

DC 電圧  仕様(詳
細：98 ページ) 

レンジ 

確度 

最大入力電圧 

400mV、4V、400V 

±(1% + 1 digit) 

400V 

AC 電圧 仕様 (詳
細：98 ページ) 

レンジ 

確度 

最大入力 

周波数 

4V、40V、400V 

±(1% + 3 digits) 

400V 

40Hz ～ 400Hz 

パネル操作 1. V スイッチを押し電圧測定を選択しま
す。警告メッセージが表示されたらい
ずれかキーを押し測定を開始します。 

V

V  

 2. 電圧測定の画面が表示されます。 

バッテリーレベル

測定単位

メータスケール係数

F1-F3メニュー

Auto/Manual
レンジ

Run/Stop

デルタ
測定結果

測定結果

メータ

-83.60mV

DCV/ACV

 

 3. AUTOSET キーを押し、DCV また
は ACV を選択します。  

AUTOSET
 

 4. 端子にテストリードを接続しま
す。 
黒色リード：COM  
赤色リード：V / Ω / C  

400V
400V
MAXCOM V/Ω/C

(black) (red)

 

 5. 測定値がディスプレイに表示されます。測定値は
常に更新されます。詳細については以下の参照く
ださい。 
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オートレンジ 電圧レンジでオートレンジを選択するに
は F3（Auto）キーを押します。ディスプレ
イ左上の表示が AUTOになります。 

F3

Auto

 

AUTO  

マニュアルレンジ 電圧レンジでマニュアルを選択するには
F1(Manual)を押します。ディスプレイ左上
の表示がManual になります。 

F1

Manual

 

MANUAL  

測定の停止 測定を停止するには RUN/STOPキーを
押します。測定結果は保持されディスプ
レイ右上に STOPが表示されます。再開
するには RUN/STOPキーを再度押しま
す。 

RUN/STOP

 

RUN

STOP  

デルタ電圧測定 デルタ値を測定するには F2 (II/Δ)キー
を押します。キーが押された瞬間の値が
ディスプレイ右上に表示され、通常の測
定値エリアは右上の値との差が測定され
ます。 

 

2. ゼロにリセット
します。

200.0V

1. F2を押します。 3. デルタ値を
表示します。
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電流測定 

DC 電流 仕様  
(詳細：98 ページ) 

レンジと確度 
 

 
最大入力電流 

40mA ±(1% + 1 digit) 
400mA ±(1.5% + 1 digit) 
20A ±(3% + 3 digits) 

400mA (direct input) 
20A (拡張モジュール使用時) 

AC 電流 仕様  
(詳細：98 ページ) 

レンジと確度 
 
 

最大入力電流 

40mA ±(1.5% + 3 digits) 
400mA ±(2% + 1 digit) 
20A ±(5% + 3 digits) 

400mA (direct input) 
20A (拡張モジュール使用時) 

パネル操作 1. A スイッチを押し電流測定を選択しま
す。警告メッセージがでたら、いずれ
かのキー（A、V、R 以外）を押し測定
を開始します。 

A
A  

バッテリーレベル

測定単位

メータスケール係数

F1-F5メニュー

Auto/Manual
レンジ

Run/Stop

デルタ
測定結果

測定結果

メータ

DCA/DCA

-83.60mA

 

 2. AUTOSET キーを押し DCA、
ACA を切り替えます。 

AUTOSET
 

測定レンジ 
0mA ～ 400mA 

1. テストリードを端子に接続しま
す。： 
黒色リード：COM 
赤色リード：mA/A 

400mA
MAX

mA/A COM

(black)(red)

 

 20A レンジに設定されている場
合、F4(mA)を押し mA レンジに
設定します。 

F2

mA

 20A mA  
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 2. オートレンジを選択する場合には
F3 (Auto)キーを押します。マニュ
アルレンジを選択するには F1 
(Manual)を押します。ディスプレイ
の左上に選択したモードが表示
されます。 

F1

Manual

 F3

Auto

 

MANUAL  AUTO  

測定レンジ： 
400mA ～ 20A 

 

1. 20A レンジを使用する場合、
COM 、mA/A 間に電流用拡
張モジュールを接続します。
そして、テストリードを拡張モ
ジュールに接続します。 

20 AMP

400mA
MAX

mA/A COM

(black)(red)  

 2. F5 (20A)を押し、20A レンジを選
択します。MANUAL モードの表
示が出ます。（オートレンジは使
用できません。） 

F5

20A

 MANUAL  

測定を停止する。 測定をホールドするには RUN/STOPキ
ーを押します。測定値は保持されます。
ディスプレイ右上に STOPの表示が出ま
す。測定を再開するには再度 RUN/ 
STOPキーを押します。 

RUN/STOP

 

RUN

STOP  

デルタ電流の測定 デルタ値を測定するには、F2 (II/Δ)キー
を押します。キーを押すとそのときの測
定値がディスプレイ右上にΔ****で表示
されます。そして通常の測定値エリアに
デルタ値が表示されます。 

 

2. ゼロ セット

20.0mA

1. F2を押します。 3.デルタ値表示
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抵抗測定 

インピーダンス仕様 

(詳細：98 ページ) 

レンジと分解能 400Ω ±(1% + 3 digits) 

4k, 40k, 400k, 4MΩ ±(1% + 1 digit) 

40MΩ ±(1.5% + 3 digits) 

パネル操作 1. R スイッチを押します。警告メッセージ
が表示されたら、いずれかのキー
（A、V、R 以外）を押し測定を開始しま
す。 

 

 2. AUTOSET キーを押します。 AUTOSET
 

 3. インピーダンス測定画面が表示されます。 

バッテリーレベル

測定単位

メータスケール係数

F1-F3メニュー

Auto/Manual
レンジ

Run/Stop

デルタ
測定結果

測定結果

メータ

インピーダンス

-100.0kΩ

 

 4. テストリードを端子に接続しま
す。： 
黒色リード：COM  
赤色リード：V/Ω/C 

400V
400V
MAXCOM V/Ω/C

(black) (red)

 

 5. 測定値が表示されます。測定値は常に更新されま
す。詳細は以下の手順を参照ください。 

オートレンジ インピーダンスレンジをオートレンジで使
用する場合は F3 (Auto)キーを押してくだ
さい。ディスプレイの左上に AUTOが表
示されます。 

F3

Auto

 

AUTO  
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マニュアルレンジ マニュアルレンジを選択する場合は F1 
(Manual)を選択してください。ディスプレイ
の左上に MANUAL が表示されます。 

F1

Manual

 

MANUAL  

測定を停止する 測定を停止するには RUN/STOPキーを
押します。測定値は保持されディスプレ
イ右上に STOPが表示されます。測定を
再開するには RUN/STOPキーを再度押
します。 

RUN/STOP

 

RUN

STOP  

デルタ値の測定 デルタ値を測定するには F2 (II/Δ)キー
を押します。キーを押されたときの測定
値がディスプレイ右上に表示されます。
そしてその値とのデルタ値が通常の測定
値エリアに表示されます。 

 

2. ゼロ セット

20.0mA

1. F2を押します。 3. デルタ値表示

 

 Diode 測定 

レンジ 0V ～ 1.5V 

パネル操作 1. R スイッチを押します。警告メッセージ
が表示されます。いずれかのキーを
押して測定を開始します。  

 2. AUTOSET キーを押し diode 測定を選
択します。 

AUTOSET
 

 3. diode 測定の画面が表示されます。 
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バッテリーレベル

測定単位

メータスケール係数

F1-F3メニュー

マニュアルレンジ

Run/Stop

測定結果

メータ

インピーダンス

 

 4. テストリードを天使に接続しま
す。： 
黒色リード：COM  
赤色リード：V/Ω/C 

400V
400V
MAXCOM V/Ω/C

(black) (red)

 

 5. 測定値が表示されます。測定値は常に更新されま
す。 

測定の停止 測定を停止するには RUN/STOPキーを
押します。測定値は保持されディスプレ
イ右上に STOPが表示されます。測定を
再開するには RUN/STOPキーを押しま
す。 

RUN/STOP

 

RUN

STOP  
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導通チェック 

状態 < 50Ω (beeping) 

パネル操作 1. R スイッチを押します。警告メッセージ
が出た場合、いずれかのキーを押し
ます。  

 2. AUTOSET キーを押し continuity を選
択します。 

AUTOSET
 

 3. continuity 測定の画面になります。 

バッテリーレベル

測定単位

スケール係数

F1-F3メニュー

（使用不可）

マニュアルレンジ

Run/Stop

測定結果

メータ

Continuity

 

 4. テストリードを端子に接続しま
す。 
黒色リード：COM 
赤色リード：V/Ω/C 

400V
400V
MAXCOM V/Ω/C

(black) (red)

 

 5. 導通状態（インピーダンス＜50Ω）の場合、ビープ
音がします。 

測定の停止 測定を停止するには RUN/STOPキーを
押します。測定結果は保持されディスプ
レイ右上に STOPが表示されます。測定
を再開するには再度 RUN/STOPキーを
押します。 

RUN/STOP

 

RUN

STOP  
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キャパシタンスの測定 

キャパシタンス仕様 レンジ 51.2nF ～ 100uF ±(3% + 3 digits) 

パネル操作 1. R スイッチを押します。警告メッセージ
が表示されたらいずれかのキーを押
し測定を開始します。  

 2. AUTOSET キーを押しキャパシタンス
（capacitance）測定を選択します。 

AUTOSET
 

 3. キャパシタンス（capacitance）画面が表示されま
す。 

バッテリーレベル

測定単位

メータスケール係数

F1-F3メニュー

（F1、F3使用不可）

オートレンジ

Run/Stop

測定結果

メータ

キャパシタンス

 

5nF 以上の測定 CX 端子にテストリードと接続しま
す。 CX

CATII
400V

 

5nF 以下の測定 

 

キャパシタンス拡張モジュールを
COM と V/Ω/C端子間に接続し
ます。そして、テストリードを拡張
モジュールに接続します。測定値
は常に更新されます。 CX <5nf

400V
400V
MAXCOM V/O/C
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測定の停止 測定を停止するには RUN/STOPキーを
押します。測定結果は保持されディスプ
レイ右上に STOPが表示されます。測定
を再開するには再度 RUN/STOPキーを
押します。 

RUN/STOP

 

RUN

STOP  

デルタキャパシタン
スの測定 

デルタ値を測定するには F2 (II/Δ)キー
を押します。キーを押されたときの測定
値がディスプレイ右上に表示されます。
そしてその値とのデルタ値が通常の測定
値エリアに表示されます。 

 

2. ゼロ セット

20.0mA

1. F2を押します。 3. デルタ値表示
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よくある質問集 

Q:質問、A：回答 

電源 Q • 電源がオンしません。 

• しばらくしたら動作しなくなった。  

 A バッテリーに充電が必要です。本体の電源をオフ
のまま付属の ACアダプターを接続し、少なくとも
15 分以上充電してください。その後、再度電源を
オンにしてください。 

マルチメータの ERR
モード 

Q マルチメータモードで、ディスプレイの上側に測定
項目が表示されてエリアにエラーメッセージとして
ERR が表示しています。 

 A “ERR”表示は測定モードが選択されていない場
合に表示されます。V, A,または R スイッチを選択
してください。 

Q 測定電圧が、実際の電圧より 10 倍くらい小さい。 オシロスコープで振
幅が間違っている。 

A プローブの減衰率が x10 に設定されています。 
プローブの減衰率を必要な値に設定してくださ
い。ｘ1 に設定した場合、400V や高い周波数は観
測できません。 

 Q 測定電圧が実際の電圧より 10/100/1000 倍大き
い。 

 A CH1,CH2 のプローブの減衰率設定をしてくださ
い。詳細は 19 ページを参照ください。 

Q 波形は表示されるが安定しない。 オシロスコープで波
形が安定しない。 

A トリガ設定を確認ください。詳細は 26 ページを参
照ください。 

• 入力信号の CH とトリガの CH を確認してくだ
さい。 

• 現在のトリガタイプがエッジトリガ、ビデオトリ
ガを確認してください。 
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• トリガ結合モードで HFrej、LFrej を切り替えて
高い周波数または低い周波数のノイズを除去
してみてください。 

オシロスコープに波
形が表示されませ
ん。 

Q ディスプレイに波形が表示されません。 

 A • トリガレベルが波形の範囲外になっています。
AUTOSET キーを押すと自動的にトリガレベル
が調整されます。 

• トリガーモードがシングル（Single）の場合、
RUN/STOPキーを押して波形にトリガをかけ
てください。トリガーモードとノーマル（Normal）
に設定してください。トリガの詳細は 26 ページ
を参照ください。 

マルチメータの更新
が遅い。 

Q キャパシタの測定では、更新に 30～40 秒掛かり
ます。 

 A 小さなキャパシタを測定するのには長い時間が掛
かります。通常、5nF より小さいキャパシタ測定で
は 30～40 秒必要です。キャパシタンス測定の詳
細は 93 ページを参照ください。 

オシロスコープの更
新が遅い。 

Q 波形の表示更新が通常より遅い。 

 A 通常より遅い場合以下のケースがあります。 

• 平均（Average）サンプリングモードが選択され
ています。 (19 ページを参照) 

• 重ね書が選択されている。（32 ページ) 
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定格 
本器の仕様は以下の条件を満たしている場合に適用されます。 

• 30 分以上エージングされ、その間の温度変化が 5℃以内である。 

• プローブの減衰率がｘ10 に設定してある。 

オシロスコープ定格 

垂直 A/D コンバータ 8 bits (2CH も同様) 

 感度 5mV/div～5V/div（at input） 

 移動量 ±50V(500mV～5V),±1V(5mV～200mV) 

 周波数帯域 20MHz 

 Single 20MHz 

 Low frequency ≥5Hz（入力結合：AC, -3dB） 

 立上り時間 ≤17.5ns (入力にて, typical) 

 DC 確度 ±5% (DC gain) 

 DC 確度 (avgas) Avg >16: ±(5% rdg + 0.05 div) for △V 

サンプリング モード ノーマル、ピーク、平均 

 サンプリングレート 100 MS/s  

垂直軸 結合 DC、AC、Ground 

 インピーダンス 1MΩ±2%// 20pF±3pF  

 プローブ減衰率 1X, 10X, 100X, 1000X 

 最大入力電圧 400V (DC+peak)  

 チャンネル間遅延 150ps (typical) 

水平軸 サンプリングレート 10S/s～100mS/s 

 補間 （ sin x ）/ x 

 メモリ長 6000 ポイント/各チャンネル 

 水平レンジ 5ns/div～5s/div, 1 - 2.5 - 5 step 

 サンプリングレート / 

relay time accuracy 

±100ppm (time interval ≥ 1ms) 

 Interval (△T) 確度 (

全帯域) 

Single：±(1 interval time +100ppm×

reading+0.6ns) Average >16：±(1 interval time 

+100ppm×reading+0.4ns) 

   

トリガ 感度 CH1 、CH2: 1div(DC～最高周波数) 
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DC 結合： ≥ 50Hz. 

 トリガレベル 画面センターから±6 div center 

 レベル確度 ±0.3 div (typical, 立ち上がり/立下り ≥ 20ns) 

 移動 655div (プリトリガ), 4div (ポストトリガ) 

 50% level setting 入力周波数 ≥ 50Hz (typical) 

 トリガ感度 2 div of peak-to-peak (ビデオトリガ) 

 ビデオ規格 NTSC, PAL, SECAM (any frequency) 

測定 カーソル △V、 △T（カーソル間） 

 自動計測 Peak-to-peak, 平均,実効値,周波数,周期 

プローブ定格 

プローブ  1X position 10X position 

 周波数帯域 ≤ 6 MHz (DC) 全帯域 (DC) 

 減衰率 1： 1  10：1 

 適合容量 10pf～35pf 10pf～35pf 

 入力インピーダンス 1MΩ±2％ 10MΩ±2％ 

 入力容量 85pf～115pf 14.5pf～17.5pf 

 最大入力電圧 150 V DC 300V DC 

 

マルチメータ 定格 

DCV 入力インピーダンス 10MΩ 

 最大入力電圧 1000V (DC または DC+AC p-p) 

 確度 ±1%±1 digit 

 分解能 400mV レンジ： 100uV 

4V レンジ： 1mV 

40V レンジ： 10mV 

400V レンジ：100mV 

ACV 入力インピーダンス 10MΩ 

 最大入力電圧 750V(RMS) 

 周波数範囲 40Hz～400Hz 

 表示 RMS 

 確度 ±1%±3 digits 

 分解能 4V レンジ： 1mV 

40V レンジ： 10mV 

400V レンジ： 100mV 

DCA 確度 40mA レンジ： ±1%±1 digit 

400mA レンジ： ±1.5%±1 digit 
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20A レンジ： ±3%±3 digits 

 分解能 40mA レンジ： 10μA 

400mA レンジ： 100μA 

20A レンジ： 10mA 

ACA 確度 40mA レンジ： ±1.5%±3 digit 

400mA レンジ： ±2 %±1 digit 

20A レンジ： ±5%±3 digits 

 分解能 40mA レンジ：: 10μA 

400mA レンジ： 100μA 

20A レンジ： 10mA 

Resistance 確度 400Ω レンジ： ±1%±3 digits 

4kΩ～4MΩレンジ： ±1%±1 digit 

40MΩ レンジ： ±1.5%±1 digit 

 分解能 400Ω レンジ： 0.1Ω 

4kΩ レンジ： 1Ω 

40kΩ レンジ： 10Ω 

400kΩ レンジ： 100Ω 

4MΩ レンジ： 1kΩ 

40MΩ レンジ： 10kΩ 

キャパシタンス 確度 ±3%±3 digits 

 分解能 51.2nF レンジ：10pF 

512nF レンジ： 100pF 

5.12uF レンジ： 1nF 

51.2uF レンジ： 10nF 

100uF レンジ： 100nF 

Diode Reading range 0V～1.5V 

Continuity シュレッショルド < 30Ω 

一般仕様 

ディスプレイ Type 3.8 インチカラー液晶ディスプレイ 

 解像度 320 (水平) ×240 (垂直)ピクセル 

 カラー 4096 色 

電源 消費電力 < 6W 

 AC アダプタ電源電圧 100V～240V AC, 50/60Hz 

 DC 入力 8.5VDC, 1500mA 

環境 操作環境 温度： 0 ～o  40℃ 

相対湿度： < 75% 

 保存温度 温度： -20  ～  60℃ 

相対湿度： < 75% 
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寸法  180 × 115 × 40 mm 

質量  645g 

 

バッテリーパック仕様 

危険性を避けるために、GDS-122 にのみご使用ください。 

 

注意 

GDS-122 をご使用する場合、まずバッテリパックをフル充電
にしてください。オシロスコープは、ACアダプタを接続すると
すぐにバッテリバックを充電開始します。オシロスコープの電
源がOFF の場合、約 4時間でフル充電します。 

 バッテリパックは、以下の状態で充電を停止します。 

• バッテリパックがフル充電のとき。 
• バッテリパックの温度が、以下の表中の動作温度仕様を
越えている場合。 

仕様および条件 充電時間（Typical） 

オシロスコープが OFF 約 4 時間 

定格 DC 7.4V / 3500mAh 

操作温度 0℃～50℃、放電・充電 

保存温度 -20℃～+60℃ 
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INDEX 
 

̶Ａ̶ 

AC カップリング 

トリガ...................................................31 

垂直.....................................................23 

ACA マルチメータ.................................94 

仕様.................................................. 107 

AC-DC アダプタ......................................9 

ACV マルチメータ.................................92 

仕様.................................................. 106 

AUTO トリガ状態..................................26 

Autoset....................................................18 

continuity, マルチメータ .................99 

diode, マルチメータ..........................98 

インピーダンス測定.........................96 

キャパシタンス測定...................... 101 

電圧マルチメータ.............................92 

auto トリガモード...................................30 

̶Ｃ̶ 

Carry, インターフェース設定..............71 

continuity, マルチメータ 

仕様.................................................. 108 

continuity,マルチメータ........................99 

coupling 

system status ...................................39 

cycle rms（真の実効値）,自動測定...43 

̶Ｄ̶ 

Data point, PC ソフトウェア ................75 

data point, 保存.....................................83 

DC カップリング 

トリガ...................................................31 

垂直.....................................................23 

DCA マルチメータ.................................94 

仕様.................................................. 107 

DCV マルチメータ.................................92 

仕様.................................................. 106 

diode 測定, マルチメータ ....................97 

仕様.................................................. 107 

display 

settings...............................................36 
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̶Ｆ̶ 

FAQ 

更新が遅い,マルチメータ............ 104 

波形が表示されない。................. 104 

frequency（周波数）,自動測定...........43 

f 測定の停止 

continuity マルチメータ ..................99 

インピーダンスマルチメータ..........97 

̶Ｈ̶ 

Hf Rjc .......................................................31 

horizontal 

short cuts ..........................................62 

̶Ｌ̶ 

LF Rjc ......................................................31 

̶Ｍ̶ 

math mode 

system status ...................................39 

mean voltage（実効値）,自動測定.....43 

multimeter 

activating............................................90 

switching to oscilloscope ...............90 

warning message ..............................90 

̶Ｏ̶ 

OSC option key .....................................65 

̶Ｐ̶ 

PC ソフトウェア 

画面の概要.......................................73 

概要.....................................................66 

起動.....................................................70 

削除.....................................................69 

PC ソフトウェア 

インストール......................................67 

カーソル測定 ....................................80 

バージョン..........................................88 

ヘルプ.................................................88 

印刷.....................................................86 

波形の観測.......................................76 

波形の保存.......................................83 

PC ソフトウェアのインストール..........67 

period（周期）,自動測定.......................43 

pk-pk（最大電圧）,自動測定..............43 

position 

shortcuts............................................65 
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̶Ｒ̶ 

Ready トリガ状態..................................26 

run トリガ.................................................27 

̶Ｓ̶ 

Scan トリガ状態.....................................26 

service operation 

about disassembly .............................4 

SET1/2, 自動測定................................43 

signal peak, viewing..............................51 

STOP トリガ状態...................................26 

stopt トリガ .............................................27 

̶Ｔ̶ 

Trig'd トリガ状態...................................26 

̶Ｕ̶ 

USB ドライバのインストール..............70 

̶Ｗ̶ 

warning message, multimeter.............90 

̶Ｘ̶ 

X-Y モード..............................................50 

システム情報....................................38 

̶あ̶ 

アクイジション ........................................34 

システム情報....................................38 

ショートカット......................................62 

インピーダンス マルチメータ............96 

インピーダンス, マルチメータ 

仕様.................................................. 107 

エッジトリガ.............................................28 

auto モード.........................................30 

single モード ......................................31 

カップリングモード............................31 

ノーマルモード..................................30 

エラーモード, マルチメータ .............. 103 

オートレンジ 

インピーダンスマルチメータ..........96 

電圧マルチメータ.............................93 

オシロスコープ 

マルチメータへの切替....................17 

使用.................................................. 105 
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̶か̶ 

カーソル測定 .........................................44 

PC ソフトウェア.................................80 

ショートカット......................................62 

電圧.....................................................45 

カップリング 

トリガ...................................................31 

垂直.....................................................23 

キャパシタンス測定, マルチメータ 

仕様.................................................. 107 

キャパシタンス測定,マルチメータ .. 101 

キャリングケース.....................................9 

グリッド（grid）, PC ソフトウェア ..........74 

グリッドカラー（grid color）, PC ソフト

ウェア..................................................75 

̶さ̶ 

サンプルモード......................................34 

しきい値, continuity マルチメータ.....99 

システム情報.........................................38 

ショートカット......................................64 

シングルトリガモード............................31 

スケール 

X-Y モード.........................................50 

拡大（zoom） ......................................49 

垂直.....................................................22 

水平.....................................................25 

波形, PC ソフトウェア......................79 

スナップショット,ディスプレイ ..............72 

スロープ, トリガ......................................29 

ソフトウェアバージョン .........................88 

̶た̶ 

チャンネル 

on/off ..................................................23 

エッジトリガ........................................30 

ビデオトリガソース...........................32 

チャンネルの反転.................................24 

チルトスタンド.........................................17 

ディスプレイ 

スナップショット.................................72 

仕様.................................................. 108 

ディスプレイ（display） 

ショートカット......................................63 

ディスプレイ外観...................................19 

データ表（data table）, PC ソフトウェ

ア..........................................................83 

テストリード...............................................9 

デルタ測定 

電圧マルチメータ.............................93 

電流マルチメータ.............................95 

デルタ値測定 

インピーダンスマルチメータ..........97 

キャパシタンスマルチメータ ....... 102 
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ドット描画................................................36 

トリガ 

auto モード.........................................30 

run/stop .............................................27 

single モード ......................................31 

sync, ビデオトリガ............................33 

エッジトリガ........................................28 

カップリングモード............................31 

システム情報....................................39 

スロープ .............................................29 

ソース チャンネル,ビデオ.............32 

チャンネル, エッジトリガ .................30 

ノーマルモード..................................30 

ビデオ.................................................31 

レベルの再設定...............................28 

レベル調整........................................27 

状態アイコン .....................................26 

状態と水平スケール.......................27 

トリガ： 

仕様.................................................. 106 

トリガのショートカット............................60 

̶な̶ 

ノイズのある信号,観測........................52 

ノーマルトリガモード.............................30 

̶は̶ 

パッケージの内容...................................9 

バッテリーレベル...................................16 

ピーク検出 アクイジションモード 

アクイジション ...................................51 

ピーク検出モード ..................................34 

ビデオトリガ............................................31 

sync.....................................................33 

ソース チャンネル..........................32 

フィールドトリガ.................................33 

ライントリガ........................................33 

フィールドトリガ,ビデオ........................33 

プローブ ....................................................9 

仕様.................................................. 106 

補正.....................................................55 

プローブ設定 減衰率...........................17 

プローブ調整 ディスプレイ減衰率....17 

プローブ調整ツール...............................9 

フロントパネル 

外観.....................................................11 

ベクトル描画..........................................36 

ヘルプ, PC ソフトウェア.......................88 

ポジション 

X-Y モード.........................................50 

トリガ...................................................27 

時間カーソル ....................................45 

水平.....................................................25 
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電圧カーソル ....................................46 

波形, PC ソフトウェア......................78 

̶ま̶ 

マニュアル,概要 ....................................14 

マニュアルレンジ 

インピーダンスマルチメータ..........97 

電圧マルチメータ.............................93 

電流マルチメータ.............................95 

マルチメータ 

continuity 測定.................................99 

diode 測定..........................................97 

インピーダンス測定.........................96 

エラーモード................................... 103 

キャパシタンス測定...................... 101 

仕様.................................................. 106 

電圧測定............................................92 

電流測定............................................94 

̶や̶ 

よくある質問集................................... 103 

エラーモード, マルチメータ ......... 103 

更新が遅い, オシロスコープ...... 104 

垂直感度......................................... 103 

電源投入......................................... 103 

波形表示が安定しない............... 103 

̶ら̶ 

ライン（Data line）, PC ソフトウェア...75 

ライントリガ, ビデオ..............................33 

̶漢字̶ 

印刷, PC ソフトウェア...........................86 

演算（math）モード ................................41 

演算モード 

ショートカット......................................61 

加算, 演算モード...................................41 

拡張モジュール 

キャパシタンスマルチメータ ....... 101 

電流マルチメータ.............................95 

環境 

仕様.................................................. 108 

操作.......................................................3 

減算,演算モード....................................41 

減衰率,垂直...........................................24 

言語 

ショートカット......................................63 

工場出荷時測定...................................57 

校正..........................................................54 

ショートカット......................................63 

仕様 

オシロスコープ............................... 105 

マルチメータ................................... 106 
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一般.................................................. 108 

時間カーソル .........................................44 

自己校正.................................................54 

自動測定.................................................43 

ショートカット......................................61 

重ね書.....................................................36 

重ね書の設定 

アプリケーション...............................53 

初期設定.................................................57 

初期設定の読出し................................57 

除算,演算モード....................................41 

乗算, 演算モード...................................41 

信号の観測,観測..................................53 

垂直 

カップリングモードの選択..............23 

システム情報....................................39 

ショートカット......................................61 

スケールの調整...............................19 

スケール調整....................................22 

チャンネル反転................................24 

ポジション調整...........................20, 22 

減衰率の選択...................................24 

垂直ポジション.......................................22 

垂直軸 

仕様.................................................. 105 

水平 

スケールとトリガ状態......................27 

スケールの調整........................19, 25 

スステム情報....................................38 

ポジションの調整.............................25 

ポジション調整..................................20 

水平軸 

仕様.................................................. 105 

測定の停止 

diode マルチメータ...........................98 

キャパシタンスマルチメータ ....... 102 

電圧マルチメータ.............................93 

電流マルチメータ.............................95 

電圧カーソル .........................................45 

電源 

安全上の注意.....................................3 

電源をオンする .....................................16 

電源電圧 

仕様.................................................. 108 

電源投入, よくある質問集............... 103 

電流用拡張モジュール..........................9 

同期,ビデオトリガ..................................33 

特徴..........................................................10 

読出し 

初期設定,ショートカット...................63 

波形 本体メモリから .......................59 

波形, PC ソフトウェア......................85 

波形の拡大(zoom) 

システム情報....................................38 

波形拡大（zoom） ..................................48 

背面カラー, PC ソフトウェア...............74 

平均モード..............................................34 

アプリケーション...............................52 
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保存 

ショートカット......................................63 

ソフトウェアでの保存 ......................83 

本体メモリ保存から.........................58 
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お問い合わせ 製品についてのご質問等につきましては、下記までお

問い合わせください。 

TEL：03-5823-5656  FAX：03-5823-5655 

E-Mail：info@instek.co.jp 
HomePage：http://www.instek.co.jp 

株式会社 インステック ジャパン 

〒101-0032 東京都千代田区岩本町 1-3-3 

 


